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Copyright
Copyright © 2017 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied solely to assist authorized
users of Objet1000 Plus 3D printing systems. No part of this document may be used for other purposes.

The specifications on which this document is based are subject to change without notice.

Trademarks

Stratasys, Objet, FullCure, PolyJet, Connex, Objet1000, Objet Studio, Job Manager, GrabCAD Print, GrabCAD PolyJet Server
are trademarks of Stratasys Ltd. and/or its subsidiaries or affiliates and may be registered in certain jurisdictions. All other
product names and trademarks are the property of their respective owners..

FCC Compliance

The equipment referred to in this guide has been tested and found to comply with the limits for a Class A device pursuant to
part 15 of the FCC rules. These limits provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. Stratasys 3D printing systems generate, use and can radiate radio-frequency energy
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification to this equipment.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it must be sent to appropriate
[Pa facilities for recovery and recycling. For information about proper disposal, check your purchase contract, or contact the
supplier of the equipment.

Limitation of Liability

The product, software or services are being provided on an “as is” and “as available” basis. Except as may be stated
specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any kind, whether express or implied,
including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental, special, consequential or
exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data or other intangible losses (even
if Stratasys has been advised of the possibility of such damages), resulting from: (i) the use or the inability to use the product or
software; (ii) the cost of procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software or data; (iv) statements
or conduct of any third party; (v) any other matter relating to the product, software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are subject to
change. Stratasys Ltd. may, at any time and without notice, make changes to this document. Stratasys Ltd., for itself and on
behalf of its subsidiaries, assumes no liability for technical or editorial errors or omissions made herein, and shall not be liable
for incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration of data,
delays, or lost profits or savings arising from the use of this document.
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Objet1000 Plus User Guide 1 About This Guide

Using This Guide

This user guide provides instructions for installing, operating and maintaining
Objet1000 Plus 3D printing systems. It explains how to use features, and
provides practical examples to guide you as you use the system.

The text and figures in this guide are based on the Objet1000 Plus 3D printer,
software version 100.3.0 and Objet Studio software version 9.2.

This guide assumes that—

« all the hardware, software, and network components of your Objet1000
Plus system are installed, configured, and operating correctly.

« the operator has a working knowledge of the Windows® PC platform.

For More Information

DOC-06810 Rev.B

Visit www.stratasys.com to download additional documents for this printer,
including documents in other languages. Also available on this site: details
about consumables and support contacts.

If you have any questions or comments about the way information is
presented in this document, or if you have any suggestions for future editions,
please send a message to c-support@stratasys.com.
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Terms Used in This Guide

Build tray

Cleaning fluid

Client/user workstation

Connex™

Digital Material

Digital Material Mode

GrabCAD Print
host/server workstation
Job Manager

Mixed part

Mixed tray

Model material

Objet Studio™

OBJDF

OBJTF

OBJZF

DOC-06810 Rev.B

In Objet Studio software: The surface displayed on the screen
that represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing block,
used to completely remove Model and Support material from
the system before loading another type of material in the
printer and before long-term shutdown. The cleaning fluid is
supplied in material containers.

The workstation on which software is installed for preparing
build trays for production on PolyJet printers. (There is no limit
to the number of client workstations.)

The technology of printing models by jetting multiple materials
simultaneously from the print heads. This technology enables
Objet1000 Plus printers to print in Digital Material mode.

Combinations of model materials fabricated in the printer from
the basic model materials installed.

The printer mode used to print a job using two different model
materials. (This mode can also be used to eliminate the need for
performing the Material Replacement procedure when printing
with a single model material.)

A software application for preparing print jobs on a variety of
3D printers, including the Stratasys Objet1000 Plus printer.

The workstation that interfaces directly with the Objet1000
Plus printer and is typically positioned next to it.

The part of Objet Studio software that manages production jobs
before they are sent to the PolyJet printer.

Models whose parts are printed using more than one model
material.

A build tray containing objects, each of which is designed to be
printed using a different model material.

Material used for building models.

A software application that prepares files for printing on
Stratasys PolyJet printers.

The extension of a file that contains information about the
geometry of an object and the materials required to print it.
objdf files are created in Objet Studio.

The extension of a file that contains all of the information
needed for a model-printing job on PolyJet 3D printers. An
objtf file is used by Objet Studio to send a print job to a PolyJet
3D printer.

The extension of a compressed “wrapper” file containing all of
the files used in an Objet Studio build tray. Using objzf files, a
printing job can be saved as a single file, for convenient storage
and transfer.
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1 About This Guide

Printer computer

Printer interface

Printer software,
printer-control
application

Resin

SLC

STL

Support material

DOC-06810 Rev.B

The computer inside the Objet1000 Plus printer that operates
it.

The GUI (graphical user interface) used for controlling the
Objet1000 Plus printer.

Software running on the computer inside the Objet1000 Plus
printer, that controls all printer operations.

The base substance from which photopolymer printing
materials are made for use in Stratasys PolyJet printers. In
Objet Studio and printer-application screens, “resin” refers to
containers of model and support materials.

A file that contains bitmaps of individual slices of an object, for
printing 3D models.

A file used for printing 3D models.

Material used for supporting the structure of models during
production.
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2 Safety

Safety Features

Interlock Switch

Safety Lock

UV Screening

Circuit Breaker

UV-Lamp Overheating
Protection

Grounded Chassis

DOC-06810 Rev.B

Objet1000 Plus 3D printers are equipped with the following
safety features:

The power supplied to the UV lamp and the motion motors is
turned off when the doors are opened.

Warning

Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your service
provider.

The doors are locked while the printer is working. The lock is
released when the printer reverts to pause or stop mode.

Warning

Do not defeat (override) the safety lock. Doing so could result
in serious personal injury. If the safety lock does not function
correctly, do not use the printer, and contact your service provider.

The transparent section of the doors blocks harmful UV
radiation, allowing the operator to view the model as it is being
made.

The power to the printer is turned off in case of electrical
overcurrent.

Note: The circuit breaker is only accessible to service
personnel.

The power supplied to the UV lamp and the motion motors is
turned off if the temperature around the lamp reaches 90°C
(194°F). A label on the UV-lamp cover indicates if the
temperature has exceeded 65°C (150°F).

The chassis of the printer is grounded, to prevent electrical
shock.

Note: The power outlet must be properly grounded, in
accordance with the local electric code, to provide this
protection.
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Emergency Stop Emergency stop switches are located on the front and back of
the printer.

Important: Pushing the emergency stop switch disconnects
power to the motors only. This switch does not disconnect the
power supply to the printer; printer circuits remain live.

Emergency Sop

UV screens

Figure2-1  Objet1000 Plus—front view

Emergency Stop

Figure2-2  Objet1000 Plus—rear view

If the Objet1000 Plus 3D printing system is not used as specified in this guide,
the safety features may not provide adequate protection.
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2 Safety

Symbols and Warning Labels

This following table lists the warning labels located on or in Objet1000 Plus

printers.

Warning Symbol

Meaning

Location

Comments

Hazard (general)

On the name plate on the

Read the instructions in

tray, visible when the
doors of the printer are
open.

back of the printer. this document before
operating the printer.
Hot surface On the print block. Risk of burns. Do not
touch this surface after
printing.
High voltage Near the UV lamp Risk of electric shock.
connectors.
Near the power-supply
enclosures.
Ultraviolet Near the UV lamps. Risk of injury from
radiation ultraviolet radiation.
Moving parts At the sides of the build | Risk of injury from moving

parts.

DOC-06810 Rev.B
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Safety Guidelines

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the system. If the system is not operated as specified,
the user's safety may be compromised.

Printer >
Installation

Printer >
Operation

Y

DOC-06810 Rev.B

Installation and removal of the printer should only be done by qualified
service personnel.

Connect the printer and the UPS unit to the electric outlet using a power
cord that is safety-certified.

Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose the
operator to serious danger from electric shock.

The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:

“The machine must be connected to a grounded power outlet.”

O FI: Laite on liitettava suojakoskettimilla varustettuun pistorasiaan.
O NO: Apparatet ma tilkoples jordet stikkontakt.

O SE: Apparaten skall anslutas till jordat uttag.

O DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.

Leave a minimum of 100 centimeters (40 inches) between ventilation
openings and walls or other objects.

The printer should only be operated by persons trained by a Stratasys
customer-support representative.

All persons operating or maintaining the printer should know the location
of first aid and emergency equipment and how to use it. Never block
access to this equipment.

Keep fingers and other body parts clear of the printer cover when closing
it.

Never attempt to open the front doors of the printer while it is working,
Never override the interlock safety switch.

If the interlock safety switch ever fails, do not use the printer.
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UV Radiation

Printer
Maintenance

> Never attempt to open the service window on the right side of the printer.
This window should always remain locked, except when the printer is
serviced by authorized personnel. Do not operate the printer if it is open.

Service window

Figure 2-3 Service window on right side of printer

> Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamps and the print block.

The UV lamps used in the printer emit dangerous radiation.

> If the UV lamps remain on when the printer is open, do not stare directly
at the UV light. Shut down the printer and call your Stratasys service
provider.

> Service operations should be performed only by qualified personnel who
have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the Objet1000 Plus
system before beginning non-routine and hazardous work.

QE{ Report any potential dangers and safety-related accidents to your safety

Model and
Support
Materials

DOC-06810 Rev.B

officer or to other appropriate authorities.

Model and Support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all Model
and Support materials used by the Objet1000 Plus system are handled in
sealed containers. Normally, operators of the printer should never be directly
exposed to hazardous materials. In the unlikely event of a leak or spill, follow
the instructions that are included with the printing-material containers used.

> Store Model and Support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

> Keep Model and Support materials away from areas where food and drink
are stored, prepared and consumed.

> Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation,
wear neoprene or nitrile gloves. If there is any chance that Model and
Support materials might splash into the eyes, wear safety goggles.
Prolonged direct contact with printing materials can cause an allergic
reaction.
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UV Lamps

DOC-06810 Rev.B

>

>

When handling UV-cured models that may not be completely cured on the
surface, common latex gloves are adequate.

To prevent respiratory irritation, ventilate areas where Model and Support
materials are used.

Clean up Model-material and Support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl alcohol
(IPA), followed by soap and water. Dispose of the absorbent material in
accordance with local regulations.

Do not wash contaminated clothing at home; clothing should be
professionally laundered.

Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing material
may re-expose the user when these items are worn.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks) during
operation, leave the room and ventilate it thoroughly for about 30 minutes.

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents
the generation of mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with
applicable regulations.
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First Aid for Working with Printing Materials

Contact with
Skin

Contact with
Eyes

Ingestion

Inhalation

DOC-06810 Rev.B

In general, try to avoid direct contact with uncured printing material. If skin
or eyes come into contact with it, wash the area immediately and thoroughly
with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing materials
contains important safety information. Keep this in an accessible place where
these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

> Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

> Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

> Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.

Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.

> (Clean and disinfect the contaminated lenses.

> Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh air immediately.

> If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

> Seek medical attention immediately.
> Keep the victim warm but not hot.
> Never feed anything to an unconscious person.

> Oxygen should be administered by authorized personnel only.
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Waste Disposal

Printing
Materials

UV Lamps
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Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).

> When removing the waste container from the Objet1000 Plus printer,
wear neoprene or nitrile gloves.

> To prevent liquid waste from splashing into the eyes, wear safety goggles.

> Liquid waste from the Objet1000 Plus printer is classified as hazardous
industrial waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

> Empty Model-material and Support-material containers contain residue of
their contents. Some leakage of this residue may occur through the broken
container seal. Therefore, handle and store empty containers with care.

> Do not attempt to reuse empty containers, and do not puncture them.

> Dispose of used containers and waste containers in accordance with local
regulations.

> Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or discard
used lamps in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such
as a syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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Welcome to Connex™ Printing

DOC-06810 Rev.B

The advanced capabilities of Connex printing systems are made possible by
technology specially developed by Stratasys for printing models
simultaneously with different model materials. Printing models with
combinations of basic materials (digital materials) enables you to choose from
a wide range of mechanical properties—from flexible to rigid—and colors.

With Connex printers, you can achieve the following results when printing 3D
models:

 You can prepare objects for printing with two designated model materials
and then print them at the same time. This enables you to assign specific
mechanical and color properties to objects.

« You can print parts of the same model—simultaneously—with different
materials (or material combinations).

+ You can print objects that have a “coating” made from a different material
than the main part of the object.

Because Connex printers can be loaded with different materials, you can
streamline and economize the process of producing models:

« Printing models made from different materials on the same build tray
(“mixed tray”), in the same print job, eliminates the time-consuming need
and expense of loading another material, flushing the system, and sending
a separate job to be printed.

* You can quickly alternate printing jobs using the model materials loaded
(or material combinations)—again, without the need and expense of
replacing materials.

Print jobs can be set up and sent to the printer with either of these
applications:

« Objet Studio

» GrabCAD Print
These applications are described in the following chapters.

Objet Studio enables you to split models into component parts (“shells”) so
you can isolate, manipulate and print parts of a model. Then, you can assign
model materials and other characteristics to the shells. However, you have
ultimate control when separating models into shells by preparing stl files with
your CAD software.
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Work Configurations

Source Files
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The Objet1000 Plus 3D printing system can be set up as a single-station
system or as a multi-station system. When connected to a local computer
network, the system can serve multiple users. In such configurations, each
user (client) prepares files for production. A server, typically next to the 3D
printer, sends jobs to the printer for production.

Figure 3-1 shows the printer set up in a multi-client configuration.

workstaions

“[ e Client
i E .'-’.-’f}.'. .

Printer

Figure 3-1 Multi-client network configuration

When jobs are sent to the printer, Job Manager, on the server computer,
arranges them according to their priorities, model-material type, and other
factors. In multi-workstation configurations, the operator of the server—
typically the production administrator—has total control over the jobs sent to
the printer, and can prioritize jobs, delete jobs, review job history and reprint
jobs.

Objet1000 Plus printing systems produce three-dimensional models designed
with most CAD tools and some other 3D applications.

Objet Studio supports these file formats:

- STL

* SLC
GrabCAD Print supports STL and, VRML files, and, in addition, native CAD
formats from these programs: Creo, SOLIDWORKS, NX, CATIA and

Inventor. To see the complete list of file formats supported by GrabCAD
Print, go to: help.grabcad.com/print/file-formats.

Objet1000 Plus systems feature the capability of producing different types of
model files simultaneously.
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STL Files

SLC Files
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STL is short for STereoLithography or Standard Triangulation Language.
This language views any object as a collection of surfaces, and describes each
surface of the object as a collection of triangles.

For example, a square can be described as two triangles; a cube (six squares)
as 12 triangles. Curved surfaces need more triangles to describe them. The
higher the tolerance (for smooth surfaces), the more triangles are needed.
The result is that high-quality object descriptions mean very heavy files.

Most CAD software can export STL files. Objet Studio opens these files for
printing models on the Objet1000 Plus printer.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in Objet
Studio may be different than the solid-object images displayed from STL files.
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Printing Materials

Objet1000 Plus printers produce models by jetting thin layers of printing
materials on the build tray, until the complete model is formed. Two types of
material are used in this process:

« Model material—which makes up the finished model

« Support material—which fills gaps and spaces in the model during
printing, and is removed after printing

% For up-to-date information about PolyJet printing materials and their
properties, go to www.stratasys.com/materials/polyjet.

Materials used for printing models with Objet1000 Plus printers are made of
resins, which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof containers, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

Storage

« To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances (such
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet
printing materials.

» When not in use, keep material containers tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

« Store material containers indoors, in a dry area with adequate ventilation,
between 15—25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to
heat or flames, containers might burst or ignite.

« Signs of premature polymerization in material containers include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can
cause resin to gel in the containers.

« Make sure that material containers are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry date
on the label is valid when properly stored in an undamaged, unopened
container. Always rotate your stock, so that the container with the earliest
date is used first.

Exposure to If printing mate'rials are not in their sealed contajngrs, make sure to shield

Light them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.
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Safety Before being cured, resins are hazardous materials. To prevent possible health
Considerations hazards, follow these precautions regarding printing materials:

« Do not expose to flames, heat or sparks.
« Prevent contact with skin and eyes.

« Ventilate areas where they are handled.
» Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

% You can find more safety information about resins in:

« "Safety Guidelines" on page 2-5
« "First Aid for Working with Printing Materials" on page 2-8

Dispose of containers of model and support material in accordance with all

Disposal applicable laws and regulations.

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the Objet1000 Plus 3D printer. Use ventilation or air-conditioning systems, if
necessary, to keep the work area within the following ranges:

+ 18°-25°C (64°—77°F)
* 30%—70% relative humidity
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Preparing Files for Use with PolyJlet 3D Printing Systems

Converting
CAD Files to
STL Format

Converting
CAD Files to
SLC Format
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Before printing design files with the Objet1000 Plus printer, make sure that
they are in a file format supported by the applications you are using to send
print jobs to the printer—Objet Studio or GrabCAD Print. (See "Source Files"

on page 3-3.)

This procedure may vary slightly, depending on the CAD software used, but
the following instructions generally apply.

To convert afile to STL format (in a CAD program):

1. From the File menu, select Save As.

2. In the Save As dialog box, open the Save As Type drop-down list and
select *.STL.

3. Click Options and set the following parameters:

O Total Quality—approximately 0.01 mm (deviation tolerance / linear-
dimension tolerance)

O Detail Quality—approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but results in
larger files and longer loading and processing times. For this reason, it is
generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and ASCII
formats can be used in Objet Studio. However, binary files are smaller, so
this option is recommended.)

5. Click OK or Save.

After converting the model files, it is recommended that you check them for
defects before opening them in Objet Studio and producing the model. You
can do this in GrabCAD Print or in a third-party STL-repair application (such
as Magics™, by Materialise®).

For more information, download From CAD to Objet Studio Workflow for
Connex Technology.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before being
saved as SLC files. Considerations for suitable model orientation are explained
in "Manual Positioning" in Chapter 3 on page 5-29.
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Objet Studio Software
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The Objet Studio program for the Objet1000 Plus 3D printing system consists
of two main screens:

« Tray Settings / Model Settings
« Job Manager
Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet1000 Plus 3D printers. Objet Studio offers you a wide
variety of file-preparation options, but always consists of the following basic
procedure:

Placing one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

el L S

Saving the tray configuration as an objtf (tray format) file
5. Sending the objtf file to the Objet1000 Plus 3D printer for production

Using Objet Studio to perform these tasks is described in detail in Chapter 5,
"Using Objet Studio".

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet1000 Plus 3D printer.

« In Objet Studio installed on the directly-connected computer (server), the
Job Manager screen displays the queue and status for all jobs sent to the
3D printer by the server itself and by all client computers on the network.
All jobs displayed can be edited and manipulated.

« In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server from
that computer. Only these jobs can be edited and manipulated from the
client computer.

Client computers can be connected, via the local network, to PolyJet 3D

printers, but only to one at a time. The Job Manager screen displays the status
of the 3D printer to which the client is currently connected.
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Workflows

With Objet1000 Plus printing systems, you have great flexibility in preparing

model files and printing them. Below are the major workflows available.
Stage Workflow A Workflow B Workflow C
CAD program* « Design a 3D object. « Design a 3D object. + Design a 3D object.
 neon s qreeyrrepm—— o + Saveitasasinglest/ <+ Saveitasan * Apply colors to parts.
ol file. assembly of st/ files.

—

— - E
Objet Studio / + Open (Insert) the stl + Open (Insert) the stl + Open (Insert) an objdf
GrabCAD Print* file. files as an assembly. file (Objet Studio).

e —p— — » Separate the object
— into its components

3 (“shells”).
1 + Assign materials to
=

the components.

* Assign materials to
the assembly’s
components.

«Save the object as an objdf file (Objet Studio,
optional).

(objdf files contain
model-material
information.)

«Save the build tray. / Send the build to the printer.

Objet1000 Plus Printer

Models are produced in the printer.

«Remove the Support material from the models

Finished model.

3D printing workflows, from design to finished models

* In addition to the options shown, GrabCAD Print supports most native CAD file formats.
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How to Install Objet Studio

Objet Studio software is installed during printer installation. This section is
provided in case you need to reinstall Objet Studio, or install it on a remote
(client) computer.

The Objet Studio setup wizard guides you when installing this software. Objet
Studio is installed on the printer-server (“host”) computer, one of the built-in
printer computers, but it can also be installed on remote, “client” computers
and on computers used to prepare files for printing models, or for training
and demonstration purposes. During installation, you choose to install either
the printer-server (“host”) application or the client application.

To install Objet Studio software:

1. Connect the USB flash drive (supplied with the printer) to a USB port.

2. On the USB flash drive navigate to the Objet Studio installation file, and
run it.

3. To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.

If you click Yes, the following screen should appear.

ObjetStudio - InstallShield Wizard | ]

Please note...

Figure 4-1 Objet Studio compatibility check

4. Make sure that your printer is compatible with Objet Studio by checking
the list displayed.

Note: The printers displayed are legacy printers that are not compatible with
this version of Objet Studio.
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5. In the Installation type screen, select the required installation option.
Select Objet Studio for a Server computer—

3 if you are installing Objet Studio on the server (“host”) computer—one
of the computers inside the printer.

3 if you are installing Objet Studio on a standalone (off-line) computer.

Select Objet Studio for Client workstations if you are installing Objet Studio
on a “client” workstation—a remote computer that prepares print jobs and
then sends them to a server computer.

ObjetStudio - InstallShield Wizard X

Installation type

Figure 4-2 Objet Studio configuration selection

6. In the Choose Destination Location screen, verify the destination folder
and click Next.

ObjetStudio - InstallShield Wizard X

Figure 4-3 Objet Studio installation-folder selection

%( It is recommended that you do not change the default destination folder.
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7. In the Select Printer Type screen, select the 3D printer used for producing

models and click Next.

Select Printer Type

Select an Objet Printer.

() Objet24 () Objet260 Connex
) Objet30 () Connex350
() Objet30 Pro () Connex500
() Objet30 Scholar () Eden260V
(7} Objet30 OrthoDesk () Eden350V
() Eden500V
() Objet 1000

Figure 4-4 Printer selection
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8. When the following screen appears, click Install to begin installation.

ObjetStudio - InstallShield Wizard

Ready to Install the Program
The wi

Figure 4-5 Ready to Install screen
After clicking Install, a progress bar shows the progress of the installation
process.

ObjetStudio - InstallShield Wizard

Setup Status

Figure 4-6 Installation progress bar

% Objet Studio requires that Microsoft® DirectX® is installed on the computer. If
necessary, an installation screen for this program will appear. To continue
with Objet Studio installation, accept the DirectX agreement.
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When installation is complete, the final InstallShield wizard screen
appears.

ObjetStudio - InstallShield Wizard

InstallShield Wizard Complete

ly installed ObjetS tudio.

Figure 4-7 Final installation screen
9. To complete the software installation, click Finish.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:

« Objet Studio
« Stop Job Manager (for servers and standalone stations)

How to Uninstall Objet Studio

If there is ever a need to uninstall the Objet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely remove
all software components.) Instead—

> From the Start menu, select All Programs > Stratasys > Uninstall Objet
Studio.
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Launching Objet Studio

Windows® 7
Security
Warning
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-

L
After you install Objet Studio, a launch icon s appears on the Windows
desktop. Open the application by double-clicking this icon, or by selecting
Objet Studio from the Start menu.

Depending on the User Account Control settings in Windows® 7, you might
see the following warning when opening Objet Studio.

r

Hy) User Account Control &J

|@ Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  ObStudio.exe
Publisher: Unknown
File origin: Hard drive on this computer

Change when these notifications appear

%

Figure 5-1 Security Warning

If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the application, unless you change the User
Account Control settings.

To prevent the warning message from appearing again:

1. Click the link at the bottom of the security warning dialog box (Change
when these notifications appear).

2. In the User Account Control Settings screen, move the slider to Never
notify.

'f:s' User Account Contrel Settings —

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer,
Tell me more about User Account Control settings

Always notify
- - Notify me only when programs try to make changes to
my computer (do not dim my desktop)
® Don't notify me when I make changes to Windows
- - settings
-
ij Mot recommended. Choose this only if it takes a long
- - time to dim the desktop on your computer.
Mever notify

1Fg) OK Cancel

Figure 5-2 Changing the User Account Control settings
3. Click OK.
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4. In the following dialog box, click Yes.

r@' User Account Control @

Do you want to allow the following program to make

changes to this computer?

I ;".| Program name:  UserAccountControlSettings
T'/ Verified publisher: Microsoft Windows

':E’::' Show details Yes ] [ iy

Change when these notifications appear

Figure 5-3 Confirming the change in the User Account Control settings

Objet Studio When Objet Studio opens, the Tray Settings screen appears, showing an
Interface empty build tray.

ObjetStudio /O = — e — Help
Commands : == g -,,\.\

MEnL Standard toolbar

i

/ Active ribbon
Quick Access
toolbar Job Manager
/ tab
Model Tres
pane

Figure 5-4 Objet Studio opening screen
The Objet Studio interface consists of two main screens:

 Tray Settings—for arranging models and preparing them for printing.
« Job Manager—for monitoring and managing print jobs.
This screen is described in "Monitoring and Managing Print Jobs" on
page 5-75.
Each screen is controlled by menus and icons on its own ribbon. An

additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.

Objet Studio anticipates your workflow by displaying and enabling the options
relevant to your current task. For example, when you first open Objet Studio,
the Model Settings ribbon is disabled until you place a model on the build
tray. Similarly, options available from the standard toolbar menus are enabled
or disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in
"Customizing Objet Studio" on page 5-63.

Instructions for using the commands for preparing models for production and
sending jobs to the printer, appear later in this chapter.

@ Beds)s Objet Studio: Objet1000, Loaded materials: VeroBlack, VeroWhite (=] E [t
| = Arrange Tray Job Manager Edit ~ View - Object ~ Tools ~ Style ~ (@) -
# o B2 I,) «‘ 2@}5 é g é . f @) ) @ ggg 8] | veroBlck - Single Material
Insert || Placement Validate Estimate Build Select New Open Save | Undo Redo Single Zoom Isometric By Legend | VeroWhite T /| Multiple Materials
Element = View = Tray~ = Material ~
Model Tray Select File Edit View Color Tray Materials

Figure 5-5 Tray Settings ribbon

‘:\\J 'b} e $ @\ s Applications - Cutting Scissors Objet Studio: Objet1000 Connex2 LI—'“—” Cl
= Tray Settings Maodel Settings lob Manager Edit - View - Object - Tools ~ Style ~ (@) ~
4 . i | 4 % 7814 mm
% B [ B S O Q @ el (@] <
"l £ Select Move Transform Lock Single Zoom Isometric 9436 Millimeter Matte| Glossy Advanced Multiple || Colors

- Element = View = Tray~ 2 7. 8.80 - Materials ~ <

Edit Selection Manipulate View Dimensions (mmj} Units Options

Figure 5-6 Model Settings ribbon
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Ribbon The following table lists the Tray Settings and Model Settings ribbon
Commands command groups, and shows when they are enabled, and where they appear.
group y Y app
Group Purpose When enabled | Tray Model
Settings | Settings
Ribbon | Ribbon
e Setting display colors. Always.
By_ Legend J J
Material =
B & Selecting perspective Models are on
soge zoom and zoom level. the build tray. ’l ’I
;'l Choose to select a plane, | Models are on
e elements, or element the build tray. ’l ’!
o groups (assembilies).
51
(Y Change the perspective | Models are on
tsometrc of the active pane. the build tray. ’l ’I
pal
(2
0= D)
e
b=
Assigning printing Build tray is
material(s). empty. ’l
Models are not
selected.
N Undoing or redoing After an action or
i actions. object selection. ’l ’I
S8 8 Opening and saving files. z/lecl)gstlz dare not ’/
New Open Save .
File
% Placing model files on the | Always.
Insert bUIld tray. J
Maodel
v ¥ 38 Pre-build/build Models are on
Placement Validate Estimate Buid commands. the build tray. J

DOC-06810 Rev.B
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Group Purpose When enabled | Tray Model
Settings | Settings
Ribbon | Ribbon
% 360 2% Uniform Scals Setting model A model is
i dimensions. selected.
2101 J
Dimensions {rmm)
k- N4 Cutting, copying, pasting | A model is
s and deleting models. selected. J
Ed
4 Moving, rotating and A model is
\ " > resizing models selected
o Trarsform  Lock 9 : ’ J
v @ + Assigning a material | A model is
»t ‘-*W*f‘”** to a model or shell. selected. J
o « Separating a model
into shells.
DD Assigning model finish A model is
Matta | - ﬂ.l.a,::?: and setting support selected. J
strength/“hollow.”
mim Setting a model’s unit of | A model is
i measure (millimeters or | selected. J

inches).

To quickly identify an icon, move the cursor over it to display a tooltip. The “Undo” and
“Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain active until
you click another button or until you press the Escape key.
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Objet Studio
Commands
Menu

Model Tree
Pane
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Clicking the © icon in the upper-left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and

options.

o e Recent trays
1 bestangn
'%3, Open
2 Traydd
'.a Savea
3 CAProgram Fiesh. . \Tray33
- Save &5

n@ Save fmap...Clri+b

\'@ [mport Packed Job,.,

% Expart Packed Job...
i
fﬁl Build Properties. .,

1,/:' Liser Preferences..,
{F

gﬂf Printer Properties...

Restart

4 Cl\Program Flesl., \Trayl

>

Figure 5-7 Objet Studio Commands menu
The Options button opens a dialog box for customizing Objet Studio.

Autorahic Placement

Automalic Lay On [Gravily)
(O Never

() Blways
() When under the lray

Large Files

&) Load Full
(O Load Paitial (reduced)

Load Search Order
O Local
(& Oniginal

| Appearance || Grid | Manipulste | Display | Settings

Quick Autornabic Placement after adding new objact

Preserve 1 mm  distance betwesn objects

[ 0K ” Cancel ] App

Iy

Figure 5-8 Options dialog box

The Model Tree pane lists the objects placed on the build tray in a parent-
child hierarchy. By default, the pane “floats”— that is, you can move it to
another position on the screen and resize it. Alternatively, you can fix its
position at the left of the application window, and even hide it.
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Assigning To enable you to assign materials and other properties to parts of objects that
Propertiesto  are hidden from view on the build tray display, you can temporarily turn off
Hidden Objects the display of some objects.

To prevent the display of objects:

1. Right-click an object, either on the build tray or in the model tree.

2. From the menu that opens, select one of the following options—
O Hide, to cause the selected object to disappear.

O Hide Others, to cause all other objects on the build tray to disappear, so
that only the selected object is displayed.

Alternately, you can clear the check box next to the name of the object
in the model tree to cause that object to disappear.

|
Figure 5-9  Left: All objects displayed; Right: Display with object hidden
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Preparing Models for Production

OBIDF Files:
Overview

Model Files

DOC-06810 Rev.B

Model preparation involves the following basic steps:

1. Place objects or assemblies on the build tray.

2. If necessary, manipulate the object’s orientation and position.
3. Select the materials and model finish.

Just as Objet1000 Plus printers can produce different models on the build
tray using different materials, you can produce components of a model with
different materials. To do this, each part of the model must be a separate stl
file.

If the model’s component parts were not saved in the CAD software as
separate stl files, you can use Objet Studio to separate the model into
component parts. (This is described in "Splitting Objects into Components"
on page 5-21 and in "Dividing Objects" on page 5-57.)

An objdf file describes both the geometry of a single object and the materials,
and finish required to print it. The objdf file can represent an object that is a
single stl file, or an object assembled from component st! files.

Objet Studio enables you to split an st file representing a complex object into
an assembly of component st! files, and save the assembly as an objdf file.
Each part (stl file) described by the objdf file can have its own model-material
characteristic, so that the Objet1000 Plus printer produces the component
parts from specific materials.

Another use for objdf files is for saving a group of separate objects on the
build tray as one unit, together with their relative positions and materials.
This is especially useful for producing models in the future with the same
materials. In fact, when you save objdf files, you specify materials for printing
models without regard to the material containers loaded in the printer. The
same object can later be placed on build trays for printing. Each time you
send a build tray to the printer, you decide whether to allow printing with
substitute materials or only with the materials specified.

The Connex version of Objet Studio enables you to display, manipulate and
print component parts of a model assembly that was saved as an objdf file,
since each component is a separate stl file. This can be useful for printing
only specific parts of a model.

Further explanations of objdf files, and their features, appear throughout this
chapter.

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
several ways:

« by inserting individual st! files (or an assembly of st files).

« by inserting an objdf file (an assembly).

« by pasting objects that you copied to the Windows clipboard.
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Placing Objects To place an object on the build tray:

on the Build
Tray

DOC-06810 Rev.B

1. Open the Insert dialog box—

O From the Object menu, select Insert.
or—

3 On the Tray Settings ribbon, click Insert

or—

O Right-click on the build tray, and select Insert from the context menu.
The Insert dialog box appears.

Look ir; | 23 Samples v ¢ G e
3 |Z)Basic Shapes
| ? ) Chess
My Recent ) Connex Samples
Documents |23 Connes:_Samples
= |)Eden_alaris_Samples
L% ) Images
Desktop |y sample file
IZ)5LC Files
I)STL Files
| Text3D
My Documents QTrayl -
W) sample file
=1
oL
My Computer
‘_-‘] File name: zample file A
-
by Metwork, Files of type: STL Files [ st w
Units: Millitd eter w [ Azsembly
Mumber of Copies : |1 e E] [] Orient Automaticaly
Coordinates
Width (] Depth [v)  Height [£)
Extents 22.9 50.2318  [229
Preview

Figure 5-10 Insert dialog box

2. In the Look in field, display the appropriate folder.
. In the Files of type field, select the file type to display.
. Select the desired file, and make sure that it appears in the File name field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in Figure 5-10.

Note: When selecting a VRML (wrl) file, the object is displayed in the dialog
box only if there is an equivalent bmp file in the same folder. Therefore, when
saving VRML files in a CAD program, a bmp file of the assembly should be
saved.

You can open several stl files to place several models on the build tray. If
you select multiple stl files that make up an assembly, you can select all or
some of the parts. To print the entire model, select all of an assembly’s
component stl files, and select the Assembly check box. This positions the
parts as a complete, integrated model instead of as independent parts. The
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effects of selecting the Assembly check box—in both the model tree and
the build tray display—are shown in the following figures.

mded Trex

Figure 5-11 Assembly check box selected—st/files are placed as an
assembly

Figure 5-12 Assembly check box not selected—st/files are placed as
parts

The Model Settings ribbon is displayed when objects are placed on the
build tray.

%{ The maximum combined weight of models allowed for printing is 135 kg. You

DOC-06810 Rev.B

can verify that the models on the build tray do not exceed this limit by clicking
Validate or Estimate. A message appears if you need to reduce the weight
of the models. If so, you can remove or resize one or more models.
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5. Select any of the following options, as required:
O Units—Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters or
inches when inserting an object. Otherwise, the size of the object on
the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see "Measurement Units" on page 5-34.

O Number of copies—How many copies of this object to place on the
build tray.

O Orient Automatically—Automatically orient objects on the build tray for
efficient model building.

O Assembly—Mark this check box if you selected multiple st! files that
are part of an assembly.

Note: The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each axis.
These dimensions correspond to the virtual “bounding box” surrounding the
object see Figure 5-51 on page 5-43).

6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

e v b S ot T - m o
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g Tege Telin Hel el o P DR - P - Ot < D - Sl

% £ T W | mm —— ‘O

I id e e Npgmexit- 3 2 nE

1 i B v b . :.--.--.--. I~ D . = ] L -

e Model Tree

| Pkl Cord e | pane

Mode
oolkbar

Figure 5-13 Default screen layout

The Model Settings ribbon is displayed when objects are placed on the
build tray.
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If the object is over a certain size, the Loading Placed Elements dialog box
appears.

Loading Placed Elements ['SZI

tadel Mame |C:\ AGRendsrBirhTray] obijtf

[ )

|C: 4. testbuild, objdf

Placed Element

[ ]

- |
Figure 5-14 Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see "Loading Large Files" on page 5-47.

Opening objdf Files

Before placing objdf files on the build tray, Objet Studio must extract the
component stl files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same
name as the objdf file, in the same location.

Loak in: | ) Samples v | ¢ ? ® [
oY |T)Basic Shapes
| :a ) Chess
My Recent ) Comnex Samples
Documents | 25 Connex_Samples
- |C)Eden_alaris_Samples
=
|_ @Images
Desktop ) sample File
|C3)5LC Files
. I)5TL Files
_,,j |C5) Textam
@Trayl
by D I
v Documents ﬂ]
by Computer
.g File name: |Tray1 hd | [ Insert l
My Network | Files of type: | Obiet Digital Files [*.obif] | [ cancel |
Unitz: Millitd erter hd
Mumber of Copies : |1 & [ Qrient Avkamaticals
Coordinates
“Width (] Depth [v]  Height £]
Extents
I aterials
Packed dzzembly File
Werowhite
Prewview

Figure 5-15 Insert dialog box (objdffile)
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Opening Objet You can open trays that were saved as objtf files. (Saving objtf is described in
Tray Files "Saving Build Trays" on page 5-62).

To place an object saved as an Objet Tray File (objtf) file on the build tray:

-1

1. From the File group, click o,
or—

From the Objet Studio Commands menu O , select Open.
The Open dialog box is displayed.

Ceen RIX)
Look in: | [2) Basic Shapes v O ¥ -
Y () Mew
Y |emma

My Recent
Documents

Desklop

My Documents
-
s
My Computer
‘:‘] File name: Trayl A
-
My Network  Files of type: Obiet Tray Files [*.abitf] v

Coordinates

Preview

Figure 5-16 Objet Tray File Open dialog box

2. Select the desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed.

3. Click Open.
Objet Studio opens the tray file.

%{ The opjiffile is actually a file containing instructions for printing—which st/ files
to print and their position on the build tray. Because the objtffile references
the stlfiles used, they must remain in the same file location as when the objtf
file was saved.
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STL file loading If there are identically named stl files in more than one location, you need to
preference ensure that the correct component stl files are linked to the obyjtf file. For
example, if there are identically named stl files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you can
set the default location from which files are loaded.

To set the Load Order:

1. From the Tools menu, select Options.
or—

In the Objet Studio Commands menu © , click Options.
2. In the Options dialog box, display the Settings tab.

Options §|

ASppearance || Grid || Manipulate | Display | Settings
Automatic Placement

Quick Automatic Placement after adding new object

Preserve 1 mm  distance between objects

Autornatic Lay On [Gravity]

() Newer
(=) Always
() wihen under the tray

Large Files

(*1 Load Full
(") Load Partial

oad Search Order
() Local
(=3 Original

I aK H Cancel ]

Figure 5-17 Options dialog box, Settings tab

3. Under Load Search Order, select an option:
O Local—to load files from the location where they were last saved.
O Original—to load files in their original location.

4. Click OK.
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Quick-Access  You can access common commands for working with objects on the build

Model tray with the convenient Model Toolbar and context menus.
Commands

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

QIKE WS
FullCure720 * 0

Figure 5-18 Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description
- Applies a matte finish to the model.
? Applies a glossy finish to the model.
& Opens the Advanced Properties dialog box for setting the Grid
Style and the Hollow option.
xl‘ﬁ" Enables dragging an object (see page 5-35).
-2

Opens the Transform dialog box for changing the object’s

position and scale.
iy Toggles the Lock Model Orientation setting.
TanaoBlack+ . Allows you to choose the printing materials.
(™ Enables you to apply a coating to the model, or change the

coating previously applied.

Right-click If you right-click on an object, a pop-up context menu is displayed from
model menu Which you can also select the model finish, change its position and scale, and
set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used

icons grouped together. See "Creating a Quick Access Toolbar" on page 5-
63.
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Selecting
Objects

Copying and
Pasting
Objects
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To manipulate an object on the build tray or assign characteristics to it (model
material, building style etc.), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is highlighted
in the model tree. You can select multiple objects by drawing a box around
them with the mouse cursor, or by pressing the Ctrl or Shift keys while
clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

 Select All
* Invert Selection
» Undo Select object

Edit = \iew = oObject -

A Undo Select object

Select All

Invert Selection

Figure 5-19 Edit menu

Sometimes, you need to select individual elements of an assembly. Other
times, you need to select the entire assembly. The Selection icon displayed on
the ribbon determines what will be selected when you click on the model:

L2 @

Select Select
Element = Group -

Selection Or  Sekction

To change the selection action:
1. On the Tray Settings or Model Settings ribbon—

a. Click the Selection icon: -« or = .
b. On the flyout toolbar, click the appropriate icon:

%
P SelectElement

-
|

Select Group
*

Figure 5-20 Selection flyout toolbar

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model tree—
individual or multiple parts or assemblies. The objects copied remain in the
Windows clipboard until you paste them onto the build tray.
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You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another one.
However, Objet Studio allows only one tray to be open at a time. For each
build tray you need to work with (at the same time), you must open a separate
Objet Studio window, by running the application again (from the Windows
Start menu).

Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. For example, if you need to change the model material
of an object (saved as an objdffile) to match the model material already used
in the production build tray, you must do so before inserting the object—on
another tray. Copying and pasting also allows you to use objects already
configured on previously-used build trays for newer projects.

You perform the Copy and Paste commands as in other Windows
applications:

« from the right-click context menu.
« by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

« You can set the distance, on each axis, between the duplicate objects.

« You can manipulate mirror images of the original object, and flip them on
selected axes.

Paste Special EI

Mumber of Copies 5
Delta
100 Y100 Z |0 T

M anipulate

Mirror [F = N =
Flip |3 Oy [z

[ 5ave as Defaults [ k. l [ Cancel

Figure 5-21 Paste Special dialog box
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Surface Finish  Models can be printed with a matte or glossy surface finish. To create a matte
finish, the printer surrounds models with a thin layer of support material.

To set the model finish:
1. Select the model.

2. Select Matte @ or Glossy «' in one of the following places:
O Model Settings ribbon, Options group
O Model Toolbar
O right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects’ surface finish
on the build tray by color. To configure how Objet Studio displays objects, see
"Setting Object Colors" on page 5-46.

Splitting You can convert a complex object to an assembly of component parts. To do

Objects into so, you split the stl file that represents the object into a group of separate stl

Components files, each one representing a component. (This is referred to in the Objet
Studio interface as separating the object into shells.) You can then assign a

model material to each stl file, and you can save the newly-created assembly
as an objdf file.

To split an object into an assembly of component parts:

1. If the object is not displayed, place it on the build tray by inserting its stl
file (see "Placing Objects on the Build Tray" on page 5-12).

The object appears—on the build tray and in the model tree pane—as a
single part. It is assigned, by default, the “primary” model material. (If
Objet Studio is configured with a secondary material, you can assign it—or
a digital material—to the entire object. This is explained in "Model-
Material Settings" on the next page.)

Figure 5-22 Object placed on the build tray from a single st/ file

Note: Thereis no need to resize or arrange the object on the build tray at this
time.
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2. With the object selected:

O From the Object menu, select Separate into Shells.
or—

I Separate to Shells

3 On the ribbon, click 1%1 .

A dialog box opens in which you can specify where to save the component
stl files. (By default, Objet Studio offers to save the new files in a folder in
the same location as the original stl file.)

Separate to Shells

Save to Folder:

Figure 5-23 Folder selection for saving st/ files after splitting into shells

3. Click OK.
Objet Studio splits the object into an assembly of component parts, each a
separate stl file (“shell”).
The object appears—on the build tray and in the model tree—as an

assembly of parts (“shells”). You can assign each part a different model
material (This is explained in "Model-Material Settings" below).

Figure 5-24 Object after being converted to an assembly of component

parts
Model-Material Before placing objects on the build tray in Objet Studio, you should pay
Settings attention to the material selection settings on the Tray Settings ribbon.
VeroBlack r Single Material
VeroWhite - + Multiple Materials

Tray Materials

Figure 5-25 Material selection settings

« By default, the material selection settings on the ribbon correspond to the
two Model containers loaded in the printer.

» These materials can later be combined to create digital materials (see
"Digital Materials" on page 5-24).
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 The material displayed on the top (VeroBlack, in the figure above) is
considered the primary model material (“Model-1”). It is assigned to
objects that do not have a material assignment when you place them on
the build tray. For example, since stl files do not contain information
about the model material, Objet Studio assigns the primary model material
to them. Also, if you try to insert objdf files whose assigned materials are
not recognized by your version of Objet Studio, you can insert the file by
substituting the primary model material for the missing materials.

Select Single Material if you want to print using only one material—both of
the material drop-down menus contain the same material. If you decide to
print with multiple materials, the material in the top drop-down menu
remains assigned to the object until you select another material.

If you insert an objdf file into an empty build tray, and the model-material
assignment does not match the settings on the Tray Settings ribbon, these
settings are changed automatically. However, if there is an object already
on the build tray whose materials do not match the material assignment in
the objdf file, you cannot place the new object on the tray. To print this
object, you have the following options:

O Instead of printing it on the same build tray, print the new object as a
separate job.

O Change the materials assigned to objects on the build tray to match
those assigned to the new object (see "Changing the Model Material"
on the next page and "Assigning a Model Material to Objects" on

page 5-25).
O Change the materials assigned to the new object before inserting it, so
there is no conflict with the settings on the Tray Settings ribbon.
To change the materials assigned to an object before inserting it:

1. Open another Objet Studio window, by running the application from the
Windows Start menu.

2. Insert the new object (objdf file) into the empty build tray.

3. Change the material selection settings on the Tray Settings ribbon to
those used on the other build tray.

4. Assign materials to the object (see "Assigning a Model Material to Objects"
on page 5-25).

5. Select the object and copy it.

6. Display the other Objet Studio window, and paste the object onto the build
tray.

Note: You can save the object with the new materials either as a new objdffile,
or by saving the original file with the changes.
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Changing the
Model Material

Digital
Materials
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When you design a build tray in Objet Studio, you can use model materials
that might not be currently installed in the printer. Because the installed
materials are displayed by default, change the material selection settings on
the Tray Settings ribbon, if necessary.

verobilack - Sarigle Materis
eroWWhite * o Multiple Materials
] tangacrey -
Biack, ViraWrae

._"M ack hBiack, ViraWW
O verodue

ergilear
L] werge
El verflrey
[ verownae =

Figure 5-26 Selecting a new model material

When two different model materials appear on the ribbon, you can produce
objects from either material or from a combination of them—digital
materials. Different pairs of model materials enable you to print objects with
unique characteristics. Different digital materials produce objects with
different shades of color. Combinations of model materials that have different
mechanical properties result in digital materials with unique mechanical
characteristics.

To view the digital materials available for printing objects (using two basic model
materials):

1. Make sure that you have selected the appropriate model materials, and
that Multiple Materials is selected.

Weisbiack - Sirgle Maberial

FialluseT 20 - o Mlultiple Matesialy
Curemitly baaded YinroBlack, VeroWhie

Figure 5-27 Material selection with two basic model materials
E
2. Click .

The Material Selection Guide appears, showing the basic model materials
(at the top of the list) and the digital materials available (combinations of
them).

[ Weio' allow [Cokeed plaitics smulstion High Dimentionsl Statdty . HDT £3C, Yelow]
| RGO Ww-001 DM [rvid Gresnish'f'elow]

[ RGO W00 rad Yellow]

I | R w00 (M odete  elow Gisen]

| RGD- w004 DM [Light Gresrih rebow]

L |RGDW-005-DM [Fale Greerich iebow]

|| RGO w-008-DM [Light Yelkow]

L RGO w-00T DM [Pale Yielow Geeery)

|| Vierowinte (Gersetal Purpose: High Dimeraional Stabdily, HDT 43C)
|| OB Goey2S [lenesal Pupase: e-Modubus 2750 MPa HDT 41C]
| D330 _Geey S [Genssl Pupose: e-Modulus 2750 MPs, HDT 410)
[N D233 Giaes/ 5 [Gsntal Puspase: e-Modulus 2750 MPs, HDT 41C)
Witk (enersl Puspode: High Dimevnanal Siabdty | HOT 430)

Helg

Figure 5-28 Material Selection Guide, showing the digital materials
available with the basic model materials
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Assigning a

Model Material

to Objects

Coating
Objects
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You can assign any of the available digital materials to objects on the build
tray.

To assign a model material to objects:

. Select an object on the build tray (see "Selecting Objects" on page 5-19).

When an object is selected, its properties—including model materials—are
displayed on the Model Toolbar and on the ribbon.

mm | (] K | ot -

Mllmeter | Matte|Giossy Advanced ':'\-F'n-_-:-:‘-!-#.-‘-—f:-d_l-.e's Ribbon
QST WS Model Toalbar
WeroWhite - o

Figure 5-29 Object properties, on ribbon and Model Toolbar

Display the material drop-down list and select the desired material.
P 5| oot L
Histhn | oy Advarced D Wer ol e i

[C] om_g110_creyes
PRy [2 om_s120_crevin
B o 5130 _Greysn
I 01 _5130_Shovess
I 0+ _5120_Shovess

Figure 5-30 Menu for assigning materials to objects

When you de-select the object on the build tray, it is displayed, by default,
with the color of the material you selected. In the same way, you can

assign model materials to each of the independent objects on the build
tray.

To separate an object into independent, component parts (each an stlfile),
see "Splitting Objects into Components" on page 5-21.

You can print composite models where the surface layer is a different material
than the inside. This can be useful to achieve unique mechanical and textural
characteristics. This technique is called “coating.”

To coat an object with a different model material:

1.

Select an object on the build tray.

2. On the Model Toolbar or the Model Settings ribbon, click 0.

The Coat with dialog box opens.
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3. Select Coat With and, from the drop-down list, select the coating material.

[“]Coat with: | FullCure?20 v
Thickness: 1 i

I Apphy l [ Cancel ]
Figure 5-31 Coating material selected

4. In the Thickness field, enter a coating thickness between 0.3 and 3

millimeters.

Note: The coating thickness does not affect the external dimensions of the
object, which remain unchanged. The coating layer replaces part of the main

model material.
5. Click Apply.

Note: When you de-select objects, they are displayed, by default, with colors
representing the model-material. Even after adding a coating to an object, its
color remains that of the main material, not the color of the coating material.

To inspect, modify or remove the coating applied to an object:

1. On the "Model Toolbar" or the Model Settings ribbon, click ¢
The Coat with dialog box opens.

2. Perform one of the following actions—

O Change the coating settings, and click Apply.

O To remove the coating, clear the Coat With check box and click Apply.

O To keep the current coating settings, click Apply or Cancel.
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Positioning Objects on the Build Tray

Automatic
Orientation

To produce models efficiently and with the required finish, it is important to
carefully position objects on the tray. Objet Studio supports the automatic
positioning of objects. However, you should check to make sure that the
objects are orientated optimally for your needs, according to the
considerations explained in "Manual Positioning" on page 5-29.

Two things that affect the positioning of objects on the tray are orientation
and placement. You can let Objet Studio determine the optimum orientation
and position, or you can control them.

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation when
placing an object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

Loak in: | [ Samples vl O E-
3 |Z)Basic Shapes
i IZichess
My Recent ) Connex Samples
Documents |23 Connes:_Samples

= |)Eden_alaris_Samples

L% ) Images

Deskiop IZ)5LC Files
I)STL Files
| Text3D
[ Trayl

My Documents
-
8
My Computer
‘_;] File name: zample file A
-
by Metwork, Files of type: STL Files [ st w
Units: Millitd eter w [ Azsembly
Mumber of Copies : |1 e E] || Orient Autarnaticaly
Coordinates
Width (] Depth [v)  Height [£)
Extents 22.9 50.2318  [229
Preview

Figure 5-32 Orient Automatically option disabled

%{ You can change the default setting, so that automatic orientation is not
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applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see "Default Settings" on page 5-
70.
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Automatic After placing several objects on the build tray, you can let Objet Studio

Positioning arrange them before printing. This ensures that the objects are positioned
properly, and that they will be printed in the shortest time and with a
minimum of material.

To automatically arrange objects on the build tray:

> On the Tray Settings ribbon, click Fesemen,
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-34 Tray arrangement after applying Automatic Placement

« Forbest results, arrange the tray with Automatic Placement,on the
Tray Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

« The physical characteristics of each type of Model material you use can
affect the positioning of objects on the tray. Therefore, select materials
before running Automatic Placement.
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Manual
Positioning
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You can change the position of objects on the build tray—even if they were
inserted with the Orient Automatically option. Tools for changing the
position of objects are presented in "Manipulating Objects on the Tray" on
page 5-31.

The orientation of models on the build tray affects how quickly and efficiently
they will be produced by the printer, where and how much Support material
is used, and whether or not model parts will have a glossy finish. Therefore,
you should consider a variety of factors when deciding how to place models
on the build tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along the
Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

> Any surfaces that come into contact with Support materials become matte.

> Since models are built up, on the Z-axis, in 16- or 30-micron layers
(according to the printing mode), it is very time-consuming to print a tall
object. From this point of view, it is advisable to place the object's smallest
dimension along the Z-axis.

> Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

> Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the build tray, the print heads only have to scan
the model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that Support material is not required
on the top of the printed model.

Recess-Up Rule
This rule considers models containing surface recesses.

> Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.
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Fine-Surface Rule

This rule considers models that have one side on which there are fine details
(like the keypad side of a telephone).

> The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at least
one side (like a pipe or a container).

> It may be advantageous to print a model standing up, so Support material
does not fill the hollow, even though printing the model lying down would
be much faster.
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Manipulating Objects on the Tray

Positioning

When you use the automatic positioning option to arrange objects on the

Objects on the build tray (see "Automatic Orientation" on page 5-27), the objects are

Z-Axis

DOC-06810 Rev.B

positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

In practice, the Objet system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects

directly on the build tray with Objet Studio is to correctly display the objects on
the screen.

To position objects directly on the tray:
1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

| Appearanice || Grid | Manipulate | Display | Settings

Automatc Placement

Quick Automatic Placement aiter adding new object

Preserve 1 mrn distance betwesn objacts

Autoratic Lay On [Giavily)
(O Never

() Blways

() whien under the tray

Large Files

(&) Load Full
{7 Load Partial [reduced)

Load Search Drdsr
O Local
(= Original

” Cancel ] Apply

[ ok

Figure 5-35 Options dialog box, Settings tab
2. In the Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

« When under the tray—The display of objects that are below the build tray is
automatically changed so that the object is at tray level.

» Never—The display of objects that are above or below the build tray is not
changed.
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Valid Object You can ensure that models do not overlap when you position them on the
Placement build tray, and that they do not extend beyond the tray.

To ensure valid object placement:
1. From the Tools menu, select Constraints Settings.

]|
Constraints
Colars
Default Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-36 Constraints Settings dialog box
2. Select Dynamic check to identify—

O invalid object placement while placing objects—On Drop selected.
invalid object placement after moving objects— While Drag selected.
objects placed beyond the tray’s boundaries—Outside Tray selected.
objects that overlap—Object Collision selected.

aaaq

%{ Even if you do not use Dynamic Check when placing objects on the build tray,
Objet Studio automatically checks if there is a problem with the positioning of
objects on the tray before sending it to the printer. You can also manually
check for problems after positioning objects (see "Tray Validation" on page 5-
50).

Note: Because of the unique characteristics of each type of model material and
finish, always check valid placement after changing the material/finish.
Remember that Objet Studio calculates the space occupied by an object
including the “bounding box” surrounding it (see Figure 5-51 on page 5-43).
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Using a Grid to Displaying a grid on the image of the build tray can be useful when

Position positioning objects. To use the grid features, select the following menu
Objects options.
Menu Option Result
Tools > Grid Displays a grid on the build tray.
Tools > Snap to grid When moving the object, it aligns with the nearest grid line.
Tools > Options > Grid | Enables you to change the grid origin
(X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them—from the
Options dialog box.

To view and change grid settings:

1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options g]
Appearance | Grid Manipulate | Display | Settings
[ Display grid
[] Shap to grid
Colars
Tile size 20 = mm
Baze -
Major divisi 10 > | tib
ajor division ilez Bt -
MNumber of tiles |32 £
Major -
Line style Dot hd
Units Millitd eter v
Origin 1] >0 >0 % |mm
[ Ok ] [ Cancel ]

Figure 5-37 Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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3D files contain an object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
> In the Insert dialog box, Units field, select Millimeter or Inch:

Look in: | ) Samples v @ ¥ e m-
Y |25 Basic Shapes
:) ) Chess
My Recert |2 Cannex Samples
Documents |2 Connes_Samples
— |Z2)Eden_Alaris_Samples
F
I. @Imagas
Desktop 1) sample file
IZ2)5LC Files
: [Z5TL Files
//' I Textan
My Documents Qmayt N
O sample File
My Computer
‘_1] File marne: | 2 ‘ I Iresert I
M

Cancel

My Netwoark

Files of type: 5 es [

Figure 5-38 Unitsfield in the Insert dialog box

To change measurement units for a selected object from the Model Settings
ribbon:

1. Open the Units flyout toolbar.

Figure 5-39 Units flyout toolbar
2. Select the measurement units desired.
To change measurement units for a selected object from the standard toolbar:
1. From the Object menu, select Change Units.

Millikd eter

Figure 5-40 Model Units dialog box
2. In the Model Units dialog box, change the setting and click OK.
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Setting Model  You can change an object’s dimensions by changing its size on the X-, Y-, and
Dimensions Z-axes, from the Dimensions group on the Model Settings ribbon.

% 3.60 | Uniform Scale
¥ 4,16
Z: 1.01

Dimensions {rmm)

Figure 5-41 Dimensions on the Model Settings ribbon
« If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

« After changing a measurement, press Enter or click in another field in the
Dimensions group.

Note: You can change the height of the objects on the build tray only if this is
allowed by the Objet Studio settings (see "Positioning Objects on the Z-Axis" on
page 5-31).

The recommended minimum size for each object on the build tray is 800 mm
(on the X-axis) and 130 mm (on the Y-axis). Although smaller objects can be
printed, these minimum dimensions ensure good print quality.

Repositioning  You can manually move and rotate an object on the build tray with the arrow
Objects keys, or by dragging it with the mouse.

To manually manipulate an object:

1. Select an object by clicking it on the build tray, or in the model tree pane.
B

2. Click #v on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-42 Manually moving an object
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3. If you click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

=

Figure 5-43 Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

Usingthe You can make precise changes to an object by changing the properties in the
Transform Transform dialog box.
Dialog Box

To access the Transform dialog box (when an object is selected):
« Click w on the Model Toolbar or on the Model Settings ribbon.
« From the right-click context menu, select Transform.
« From the Object menu, select Transform.

Transform E'
Width<]  Depth(Y] Height@)
Translate:| @ 3| [0 3| | |
Rotate: |'3' :| |'3' $| |':' :|
s [12) 13 [13]
[7]Uniform Scaling | épply || Resst |

[ Cancel Actions ]

Figure 5-44 Transform dialog box

To change an object with the Transform dialog box:

> Change any of the values, then click Apply to see how the object changes
on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see how
the object changes on screen each time you click Apply.
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To reset all of the values in the dialog box:
> Click Reset.

Note: The object does not change. Any changes previously applied remain.

To undo all changes made with the Transform dialog box:
> Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.

Changing an There are several methods for changing the orientation of objects on the
Object’s build tray.
Orientation To rotate an object:
> Select the object and use the Object menu options (see also "Repositioning
Objects" on page 5-35).
To re-align an object’s plane:
1. On the Tray Settings or Model Settings ribbon—

a. Click the icon in the Selection group: sl OT
b. On the flyout toolbar, click the Select Plane icon:

Y
Select
Element =

?ﬁ'&. ckion
] h-TtJ

@

or—
From the Tools menu, select Plane Alignment > Select Plane.

DOC-06810 Rev.B 5-37



Objet1000 Plus User Guide

5 Using Objet Studio

DOC-06810 Rev.B

2. Click on part of an object on the build tray.

The selected plane is displayed.

i_“}" Y
&= g

Figure 5-45 Aligning by plane

Alignment toolbar

Selected plane

3. On the Alignment toolbar, click an appropriate icon to change the

From the Tools menu, select Plane Alignment, and select an alignment

alignment.

or—

option.

[ Flane Alignment r

Professional Mode
TimeMaterial Estimation
Assembly Map ...
Language...
optians. ..

Figure 5-46 Tools menu, Plane Alignment options

& & Ay A

N

LR - )

Select Plane
Align Botkom
Align Top
Align Eront:

| Align Back.
! Align Left

Align Right
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To cancel plane selection after re-aligning objects on the build tray:
> On the Tray Settings or Model Settings ribbon—

a. Click the icon in the Selection group: sl OT
b. On the flyout toolbar, click the Select Element or Select Group icon:

el

Sebect
Plans ~

or—

> From the Tools menu, select Plane Alignment > Select Plane.

To flip an object 180 degrees on any axis:

1. Select the object.

2. From the Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:

1. Select the object.

2. Display the Transform dialog box (see Figure 5-44 on page 5-36).
3. Change the Rotate parameters for each axis.
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Ungrouping
Objects
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You can manipulate two or more objects on the build tray, at the same time.
« Selecting multiple objects

Manipulating done to one object affects all selected objects. For example,
turning one object on its axis causes all selected objects to turn on their
respective axes.

« Converting the objects to an assembly

Separate objects become parts of one unit. For example, turning the
assembly on its axis causes all its component parts to turn as one unit.

To convert objects to an assembily:
1. Select the objects (see "Selecting Objects" on page 5-19).

2. From the Object menu, select Group to Assembly.

In the model tree, the objects now appear as children of a parent
(assembly).

Model Tree

= ﬁ Trayl
[ 1] shder
SN Acsembly2
Pocket Card Holder _Shelll
Packet Card Holder_Shelz
Pocket Card Holder_shelt3
| Procket Card Helder_Sheld
| Packet Card Holder_Shels
Pocket Card Holder _Shells
Pocket Card Holder_Shel?
Pocket Card Helder_Shels

LA AR AR AR AL AL LY

Figure 5-47 Assembly in the model tree

After creating an assembly, you can save it as an objdf file, for re-use. (Saving
the assembly is not necessary for manipulating and printing it.)

To save an assembly:
1. Select the assembly (either on the build tray or in the model tree).

2. From the Objet Studio Commands menu O , select Save As.

3. In the Save As dialog box, select the objdf format, choose a location, name
the file, and click Save.
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To separate assemblies into individual objects (st/files):
1. Select the assembly (either on the build tray or in the model tree).

2. From the Object menu, select Ungroup.
In the model tree, the elements are not parts of an assembly.

Model Tree

= Trayl
ﬁ- [ ] shder

| Pocket Card Holder_Shelll
| Pocket Card Holder_Shell2
| Pocket Card Holder_Shel3
Pocket Card Holder_Shelt
Pocket Card Holder_ShellS
Pocket Card Holder_Shelé
| Pocket Card Holder_Shel7
| Peschet Card Holder_shels

AR

Figure 5-48 Separate objects in the model tree

Freezing Model If you manipulate an object on the build tray, you can freeze its orientation so
Orientation that it does not change when you position it automatically (see "Automatic
Positioning" on page 5-28).

To freeze an object:
1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click .

To unfreeze an object:

> Select the object and click # (to de-select it).
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Display Options

Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid (“shaded”)
objects.

Figure 5-49 Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

> From the View menu, select WireFrame.

Figure 5-50 Tray and model displayed in WireFrame view

Torevert to the shaded view:

> From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions instead of their
shape:

> From the View menu, select Display Bounding Box.

Figure 5-51 Model displayed with bounding box

To display the area around objects needed for support material (to produce a
matte finish):

> From the View menu, select Display Thickening Box.

Figure 5-52 Model displayed with thickening box

To display the maximum build height:
> From the View menu, select Display Tray 3D Box.

Figure 5-53 Tray 3D Box

To display objects without the build tray:

> From the View menu, clear (de-select) the Display Tray option.
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Screen Layout Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-54 Screen layouticons

O Single View Bl is the default screen layout.

O 4Views displays perspective, top, front and right views.

Figure 5-55 Single-view screen layout

— To= sTaTE

!

TTTTT
1

- [ | — il
 —— - r—# B  A— 1

Figure 5-56 4-view screen layout
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Tray
Perspective

Tray Positioning
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The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

Isometric

‘tﬂ@@@@
R

Figure 5-57 Perspective toolbar

2. Click the icon that represents the desired perspective.

To view the tray and models from different directions, you can move the tray
around the screen and change its display angle.

To move the tray in the Objet Studio screen:

> Press the mouse wheel while moving the mouse.

Figure 5-58 Tray after moving it in the Objet Studio display
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To manually rotate the tray:

> Press Alt and press the mouse wheel while moving the mouse.

ree

Figure 5-59 Tray after rotating it upside-down
To view the tray and models from different directions, you can change its
display angle.

Setting Object The color of objects on the build tray can indicate how they are printed. Objet
Colors Studio enables you to choose the color display so that you can easily see the
material, surface and coating of objects.

To choose how colors are applied on the display:

> On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

By
Material - Color Indicates Model material
%’,ﬂf Color
1 \ﬂ"—/ Colorindicates Model surface
@ Colorindicates if coating is used

Figure 5-60 Colors display options

% Before sending a build tray to the printer, or when you perform tray validation,
Objet Studio checks if there is a problem with the stlfiles or the positioning of
objects on the tray. If so, the affected objects are displayed with special colors
(see "Tray Validation" on page 5-50).
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Loading Large Very large stl files can be slow to load and may be difficult to manipulate

Files easily on the build tray. If this is the case, you can display just an image of the
object on the build tray without loading the entire file. The st! file itself is not
changed, and the complete file is sent to the printer.

To display an image of st/ files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Options r?l

| Appeaiance Grid | Maripuiale | Disslay | Seltngs |
Autematic Flacemenk
Quick Autcratic Flacsment alter adding new ckiect
Pleserve Il mm  distance bebween objects

Auteenatic Lay On [Gravily)
O Mever

) Blways

Crwhen unde the Iray

Large Files

) Load Full
(%) Load Partial [reduced|

Load Search Urder

O Local
& Original

Figure 5-61 Options dialog box, Settings tab
2. In the Large Files section, select Load Partial (reduced).

Large File If you need to work with a detailed model that is composed of a large number

Manipulation  of polygons, you can speed up its display and manipulation in Objet Studio by
reducing the number of polygons on the screen. Although this may reduce
the resolution on the screen, it has no affect on the printed models.

_—

Figure 5-62 Object displayed without polygon reduction
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_—

Figure 5-63 Object displayed with only five percent of its polygons
showing

To use polygon reduction:

1. From the Tools menu, select Options.
or—

From the Objet Studio Commands menu Q , click Options.
2. In the Options dialog box, display the Display tab.

| Appearance || Grid || Manipulate| Display |Settings|

[[] Enable Polygon Reduction

Display while chanaing wiew
(® Bounding Box

Adaptive Polygon Reduction
() Entire Object

Diizplay when static view

O Bounding Box
Paolygon Reduction [Percents] l:l
(%) Entire Object
Save Polpgon Reduction Data
[ QK ] [ Cancel ] Apply

Figure 5-64 Options dialog box, Display tab
3. Select Enable Polygon Reduction.
4. Select Polygon Reduction (Percent).

5. Enter the percentage of total polygons to display.
When you click Apply, the display changes.
Note: The setting affects the static display (when the object is not being
moved).

6. Set display options when the object is being moved (Display while
changing view):

O Bounding Box—A box representing the object’s maximum dimensions
is displayed.
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O Adaptive Polygon Reduction—Varying degrees of polygon reduction
are applied, as necessary.

O Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog box.

%{ Selecting the Entire Object option cancels polygon reduction.

Object display The display format affects how quickly objects display. For example, if you
options select Bounding Box, objects display faster than they do when you select

Zoom Options

DOC-06810 Rev.B

Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in static view:
1. Select to display objects:

O With a Bounding Box (see Figure 5-51 on page 5-43)

O With Adaptive Polygon Reduction (changing view only)

O With Polygon Reduction (static view only)

3 Entire Object
2. Click OK when done.

While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

Zoom Object

Zoom Tray

Zoom by Rectangle

Figure 5-65 Zoom flyout toolbar
O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.

O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See "Automatic Zoom" on page 5-70.
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Handling Trays

After preparing models on the build tray, you can do the following:
« Test that it can be printed ("validation").
« Calculate the time and material resources needed to print it.
« Send it to the printer for production.
« Save it for later completion or printing.
« Save it as a compressed file for convenient storage and transfer.

Tray Validation Before sending a job to the printer for production, you should check that the

DOC-06810 Rev.B

tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling material,
make sure that the correct material is selected before performing Tray Validation.

To validate that the tray can be printed:

> On the Tray Settings ribbon, in the Build Process group, click vsidsts.
or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

]|
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-66 Color code

Note: The “Both” color also indicates a problematic st/ file.
The validation status appears on the bar at the bottom of the screen.

Yalidation succeeded Maodels: 1

Figure 5-67 Validation details in status bar

If the maximum combined weight of models on the build tray exceeds
135 kg, a warning message appears. If so, you can remove or resize one or
more models before sending the tray to the printer.
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Objet Studio enables you to calculate the time and material resources needed
for producing trays before sending them to the printer. The time it takes
Objet Studio to perform this calculation depends on the number of objects on
the tray and their complexity. Calculating the production estimate for a full
tray could take up to 15 minutes, depending on your computer’s
specifications.

To calculate the time and materials needed for producing the current tray:

> On the Tray Settings ribbon, in the Build Process group, click .

While the estimate is being calculated, a progress bar is displayed—on the
right side of the status bar (at the bottom of the screen).

—_—

| —Cancsl

Figure 5-68 Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in a dialog box.

Production Estimates g|
Frinting Mode FullCure?20 Consumption Support Consumption Build time:
High Quality 14y 48y 02:19
High Speed 103 g 3y 01:25
Digital Material 107 g 39y 02:39
[ heb | [ ok |

Figure 5-69 Production resource calculations for different printing modes

As shown in the Production Estimates dialog box, the resources needed for
producing the models on the tray depend on the printing mode used by the
printer when producing the job. You might want to consider these estimates
when deciding on the printing mode (see below), and whether or not to allow
using substitute model materials when printing the job.

Note: You select the printing mode and material substitute options after you
send the build tray to the printer (see "Printing the Tray" on page 5-53).

If the maximum combined weight of models on the build tray exceeds 135 kg,
a warning message appears. If so, you can remove or resize one or more
models before sending the tray to the printer.
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Printing Modes Objet1000 Plus printers can build models using three possible printing modes.
HQ (High Quality) Mode—

« Models are printed in 16-micron layers, resulting in smooth surfaces,
suitable for producing fine-detailed and delicate items.

« Almost twice as much time is required to print most trays, compared to
the High Speed setting,.

« This setting is only available when model material can be used in four
print heads, in single-material printing.

QE{ Single-material printing: All print heads print models without regard to the
source of the model material. This happens in the following situations:

« All print heads are supplied with one model material.

« Each pair of print heads is supplied with a different model material, but
models are printed as if they were the same material. The result is an
arbitrary mixture of materials in the printed model.

HS (High Speed) Mode—

» Models are produced in 30-micron layers, suitable for producing larger
models.

» Much less time is required to print most trays, compared to the
High Quality setting.

« This setting is only available when model material can be used in four
print heads, in single-material printing.

Digital Material Mode—

» Used when producing trays designed to be fabricated from two model
materials.

« Used when producing a tray containing two or more models, each
designed to be made from a different (single) model material.

» Used when producing models from only one of the model materials loaded
in the printer by printing with only two of the print heads.

» Models are produced in 30-micron layers, but the printing is near-high
quality.

« Printing time is similar to printing time in High Quality mode.
Although printing time is longer than with High Speed mode, Digital
Material mode can make material replacement unnecessary—saving both
time and the cost of wasted model material.

Digital Material Mode is selected automatically when more than one model
material is assigned to objects on the tray.

You can see estimates of time and material resources needed for printing trays
using the different printing modes (see "Production Estimates" on the
previous page). You also see these production estimates when you send the
tray to the printer. At that time, you can select the printing mode, including
an option that enables Objet Studio to print the tray by the most efficient
method (see "Printing-Mode Selection" on page 5-54).
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You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of stl files) because the size of a file is
typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.

To e-mail afile:

1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the
e-mail form.

2. Enter the e-mail address and send the file.

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the printer.

To send the tray to the print queue:

1. On the Tray Settings ribbon, Build Process group, click e,

O If printing the tray requires two model materials (Digital Material
mode), the Job Summary dialog box opens.

Job Summary
This Job will be printed in Digital Material™

Material and Time Estimates:

Frinting Mode
Digital Material

FullCure?20 Consumption
142 g

WeroBlack Consumption

30y

Build tirme:

02:34

Support Consumption

74y

I Fine Estimation ]

[ rew ||

Buld | [ Cancel |

Figure 5-70 Job Summary when printing with multiple model materials

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required to print
the job. For a more accurate calculation, click Fine Estimation.

Continue with step 4 on page 5-56.
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O If printing the tray requires only one model material, the Printing
Mode Selection dialog box opens.

Printing Mode Selection @

Select Printing Mode

I High Quality ' High Speed (&) Autamatic

Material and Time Estimates
Frinting Mode FullCure?20 Consumption Support Consumption Build time
High Quality 186 g 78 g 02:15
High Speed 145 g 71y 01:22
Digital Material 149 g 74yg 02:37

[ Fine Estimation ]

(oo ) [von ] [ cwen ]

Figure 5-71 Printing Mode Selection dialog box

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required to print
the job. For a more accurate calculation, click Fine Estimation.

O If the maximum combined weight of models on the build tray exceeds
135 kg, a warning message appears. If so, you can remove or resize one
or more models before continuing,.

Select the appropriate printing mode.
Printing modes are explained on page 5-52.

O If you require the job to be printed in High Quality mode, select this
option.

Note: The availability of High Quality mode depends on the material
selected.

O If you require the job to be printed in High Speed mode, select this
option.

O If you do not require the job to be printed either in High Quality or
High Speed mode, select Automatic.

This setting enables the Objet1000 Plus software to determine (just before
printing) the most efficient way to print the tray. Digital Material mode is
used if this removes the need to perform the Material Replacement
procedure. Otherwise, High Speed mode is used.

For example, if printing the tray requires only one of the model materials
loaded in the printer, only the two print heads using that material are used
to print models—Digital Material mode. (High Quality and High Speed
modes call for printing model material with four heads, which would
require you to perform the Material Replacement procedure.)

On the other hand, if printing the tray can be done using four print heads
without running the Material Replacement procedure, High Speed mode is
used. This is possible if all print heads are supplied with one model
material, or if you allow printing with an arbitrary mixture of similar
materials (see below).
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Model Quality When Digital Material Mode is Used

« Near-high-quality is achieved for most models.
« If all objects on the tray are inserted from individual st/ files, they are

printed with the standard resolution of 600 dpi (dots per inch) along the
Y-axis—unless glossy finish is required (see "Surface Finish" on page 5-21).

« If there is an assembly on the tray, all of the models on the tray are printed

with a resolution of 300 dpi along the Y-axis.

. Click Next.

The Model Material Substitution dialog box opens—if this is relevant for
the tray. (If not, the Job Summary dialog box opens—continue with step

4.)

Model Material Substitution E]

Can another model material be used instead of the
one you selected?

O Yes, use any material with similar characteristics,
) Mo, use OMLY the selected model material.

| Back | | Build | |[cancel | | Help |

Figure 5-72 Model Material Substitution dialog box

If you allow the use of substitute model materials, the printer will use
different materials whose characteristics (strength, flexibility, etc.) are
similar to those of the material you assigned to the object when designing
the build tray—under the following conditions:

O The material you assigned is not installed in the printer at the time of
printing.
In this case, the tray is printed with either one or two substitute

materials (depending on the materials installed in the printer at the
time of printing). If possible, High Speed mode is used.

O In addition to the material you selected, there is another (similar)
material installed in the printer at the time of printing.

In this case, High Speed mode is used, by printing with a mixture of
the two materials (as if they were the same material).
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4. Click Build.

If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors (see
"Tray Validation" on page 5-50), and a warning message appears.

Warning

Overlapping objects!
- Click Mo to separate objects manually
or with Automatic Placemert.

- Click Y'es to print the tray az is.

Do you want to proceed anpway?

Figure 5-73 Tray validation warning message

3 To cancel the Build command so you can correct the problem, click
No.

O To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See "Monitoring and Managing
Print Jobs" on page 5-75.
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The following topics describe additional features available in Objet Studio:

« Dividing Objects
« Displaying the Cross Section of Objects
« Saving the Screen Display as an Image File
« Saving Build Trays
You can use the Split Object feature to produce objects larger than the tray

area by dividing the model into separate parts. With this feature, you produce
only a specific section of a model.

To split an object:
1. Select the object.
2. From the Object menu, select Split.

3. In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its axes,
by entering either exact measurements or the number of parts.

Model Tree

@ Trayl
| applications - FLUTE_Shell3_Part1
_ | applications - FLUTE_Shell3_Part2

Object Size i5 25 225048
©spitbysze (347 |[37 202 | [ Defaut

) Split by Mumber I:“:“:l

Figure 5-74 Split Object dialog box
4. In Save to Folder, enter the folder name.

5. Click OK.
The composite parts are saved as new stl files with “Part 1,” “Part 2,” etc.,
added to the original file name.

Note: Before printing the newly created st/files, it is recommended that you
check them for defects in an STL-repair application, such as Magics™, by
Materialise®.
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Choosing the  When producing models, support material fills some hollow and empty
Support sections (see "Manual Positioning" on page 5-29). Objet Studio allows you to
Strength adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or
small/delicate models. For most purposes, the default setting provides
adequate support strength.
To change the strength of the support structure used when printing a model:

1. Select a model on the tray.

2. On the Model Settings ribbon, in the Options group, click % .
or—

3 On the Model Toolbar, click % .
or—

O From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

Advanced Properties E

Grid Style [ ] Hallaw
{#) Standard

) Heawy
) Lite

Apply

Figure 5-75 Advanced Properties dialog box

Note: If an object is split into shells, the Advanced Properties enabled vary
with the object selection. If a single element is selected only Hollow is
enabled. If a group of elements is selected only Grid Style is enabled.

3. In the Grid Style section, choose the support strength suitable for the

selected model. You can select a different support strength for each model
on the tray.

O Standard—for models needing average support (most models).
O Heavy—for large models needing much support.

O Lite—for delicate models needing little support. (This setting makes it
easy to remove the support material.)

4. Click Apply.
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“Hollow"™— Many objects placed on the tray from stl files are “solid.” This means that,

Filling Models  when printed, the model will be completely filled with model material. Often,

with Support  especially with large objects, this is unnecessary. Instead, the model can be

Material filled with support material, which is less costly. It is also advisable to fill
models with support material when preparing them for investment casting,
since this material burns off more quickly during the process of making the
cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than 0.5
millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
3 On the Model Toolbar, click * .
or—
O From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties El
Grid Style Huollonwy
{*) Standard
) Heawy Shell Thickness: | 1.35
" Lite

Figure 5-76 Advanced Properties dialog box
3. Set the shell thickness, in millimeters.
4. Click Apply.

Note: Thereis no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.

2. Access the Advanced Properties dialog box, as above.
3. If you change or cancel the Hollow setting, click Apply.
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The Section feature enables you to view the interior of an object by “slicing” it
on any axis. You can then manipulate the object to inspect the interior from
different angles. This may be important for deciding on the type of support
necessary when producing the model (see "Choosing the Support Strength"
on page 5-58). Displaying an object’s cross section only affects how the tray is
displayed on the screen; it does not change the object itself.

To display a cross section of the tray:

1. From the Tools menu, select Section.
The Section dialog box opens.

Section l

W Enable Clipping

Figure 5-77 Section dialog box
2. Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that you
see the cross section you want.

Figure 5-78 Left: Whole view; Right: Cross section view after using the
Z-slider
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Saving the You can save the image displayed in the active viewing screen as a graphic file.
gg raer? n Display To save the screen display as an image:
Image File 1. Press Ctrl+B.

or—

From the Objet Studio Commands menu O , select Save Bitmap.
The Save Bitmap dialog box opens.

Save Bitmap @
Save in: | 3 STL Filez j |‘j( Ed-
[=2-0086 G0 To Lask Folder Visited
20148
:*Applications - Tab Coating.bmp
*TrayS.bmp
File name: |Applications - Tab Coating
Save as ype:  (PETERIES Cancel
[rata Type: |F|GB True Color  [24-bit] j
Compressior: | Mon-Compressed j

Figure 5-79 Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.

At the bottom of the dialog box, enter a file name.

Open the Save as type drop-down list, and select the file format.
Click Save.

A
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You can save your work in different Objet Studio file formats, depending on
how you want to use them later.

objtf files contain instructions to Objet Studio and to Objet1000 Plus printers
for displaying and producing the stl files used on the tray. When you save
build trays in Objet Studio, they are saved as objtf files.

Saving in objtf format is useful, for example, if you have not finished
preparing the tray for printing, or if you want to make changes before
printing it again in the future. objtf files are also useful when working from
your company's network, where the STL files are stored.

Note: Because the objtffile references the st/ files used, they must remainin the
same file location as when the objitf file was saved.
To save the tray as an objtffile:

8

A
> In the Tray Settings tab, File group, click **.
To open trays saved as objtf files, see "Opening Objet Tray Files" on page 5-16.
To conveniently save all of the files as they are positioned on the build tray,
for storing the job, or for transferring it to another location, Objet Studio
compresses them into one objzf file. To later use the objzf file, the file must

first be expanded in Objet Studio and its component files saved.

Note: If you export an objzffile containing a st/ file originally saved as read-only,
you cannot open (import) this objzffile to the folder where the read-only st/ file is
saved.

To create an objzffile:

1. From the Objet Studio Commands menu © , select Export Packed Job.
The Save As dialog box opens.

2. Select the folder, set the file name, and click Save.

Note: You can also export a print job as an objzffile from the Job Manager
screen—see "Additional Server Features" on page 5-81.

To open an objzffile:
> Double-click on the objtf file.
or—
1. From the Objet Studio Commands menu © , select Import Packed Job.
2. In the Open dialog box, display the appropriate folder and select the file.

3. In the Browse for Folder dialog box, display the folder in which you want
Objet Studio to expand the compressed file, and click OK.

The objtf file and associated stl files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

O Creating a quick-access toolbar for frequently used commands.
O Changing the position of the Quick Access toolbar.

O Minimizing the ribbon.

O Changing the Objet Studio color theme.

O Configuring default settings for objects placed on the build tray.

Creating a As you work with Objet Studio, you may use certain commands frequently.
Quick Access You can create a quick-access toolbar to make your work easier.

Toolbar To create a quick-access toolbar:

1. Above the ribbon tabs, click ~ .
The Customize Quick Access Toolbar menu opens.

| L

Customize Quick Access Toolbar
Inzert
Placernent
Estimate
Ewild
Cpen, ..

Mare Commands. ..

Shiow Below the Ribbon

Minimize the Ribbon

Figure 5-80 Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

! T Job Mana

ray Setkings

B ¥[3 &

Insert || Placement Yalidate Estimate Build

Model Build Process

Figure 5-81 Quick Access toolbar
To add another command, repeat the above procedure.
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3. To choose from a wider range of commands:

O From the Customize Quick Access Toolbar menu (see Figure 5-80 on
the previous page), select More Commands.
or—

O Right-click on the Objet Studio Commands icon © , or elsewhere on
the ribbon, and select Customize Quick Access Toolbar.

Cuskomize Quick Access Toolbar...

Showe Quick Access Toolbar Below the Ribbon

Minirnize the Ribban

Figure 5-82 Right-click ribbon menu
The Options dialog box opens.

Options

Customize Choose commands from:
*opular Commands Eﬁ Job Manager...
Commands:
<Separator:
% Automatic placement
& Build
:'\;‘ Ingert Model
< tew R
4 Open
& Placement validation -
& Save
[ Shaw Quick Access Toolbar below the Ribbon
Keyboard shortcuts:
Ok ] [ Cancel

Figure 5-83 Quick Access Toobar Options dialog box

4. Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

5. Select a command and click Add.
6. Click OK.
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Hiding the To make more room for displaying the build tray, you can hide the Objet
Ribbon Studio ribbons.
To hide the ribbons:

1. Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands menu © .
2. Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon icons by
clicking Tray Settings or Job Manager on the menu bar. When you next
click outside of the ribbon, it disappears again.

To return the permanent ribbon display:

> Repeat the steps above to cancel Minimize the Ribbon.

Display Colors You can customize some of the colors used for displaying Objet Studio screens
and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Options.

Options. Iﬁ

Appearance |Grid | Manipulate | Display I Seﬁingsl

Select Indication

Mode Shaded w2

Color

[ Transparert

Window's Background Calor
) Colar

@ Gradient

Default

[ ok [ caneel |

Figure 5-84 Display settings
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2. In the Appearance tab of the Options dialog box, you can configure the
display.
O The Mode selection determines how models appear on the build tray.

The default method for displaying models on the build tray is as solid
(“shaded”) objects. The other options are WireFrame and Points.

O If Shaded is selected, you can display the model on the tray as a see-
through object.

Figure 5-85 Transparent display
O Double-click the color patches to customize colors.

O The Windows Background Color settings enable you to change the
color behind the build tray—with either a solid or a two-color gradient.

O To return to the default display settings, click Default.

Changing Color Objet Studio offers a choice of four background color themes—blue, black,
Themes Silver and aqua.

o*: Cr—— or i
resy 4 3 3 oS s B AV I B ovb
; R

(5]
lie |

= T T

Figure 5-86 Background color themes

To change the color theme:

> From the Style menu, select one of the options.
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Keyboard You can define shortcut keys for frequently used commands.

Shortcuts To define shortcut keys:

1. Above the ribbon tabs, click ~ .
The Customize Quick Access Toolbar menu opens.

el

Customize Quick Access Toolbar

Inserk
Placerment
Estimate
Build
Qpen...

More Commands., ..

Show Below the Ribbon

Minimize the Ribbon

Figure 5-87 Customize Quick Access Toolbar menu
2. Select More Commands.

The Options dialog box opens (see Figure 5-83 on page 5-64).
3. Click Customize.

The Customize Keyboard dialog box appears.

Customize Keyboard E|
Categories: Commands:
~
Print Preview Build Properties
Arange Tray Drefault Properties. ..
Model Settings Exit
Job Manager Export Packed Job...
Import Packed Job...
Job Manager...
I achine Properties L
Current Keys: Fress new shortcut key:
Harme
Aszzigned to:
[Unazsigned]

Set Accelerator for:

Default v O

Description:
Build

Figure 5-88 Customize Keyboard dialog box

4. Select command Categories to display all the commands in that category,
for example, all the Model Settings commands.

Current shortcut keys are displayed.
5. Enter the shortcut key in the Press new shortcut key field, and click Assign.
6. If you want to redefine all shortcut keys, click Reset All.
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You can change several Objet Studio settings that affect objects placed on the
build tray.

To change default settings:

> From the Objet Studio Commands menu © , select User Preferences.

User. Preferences E|
Building Style iarid Style
(%) Matte () Standard
() Glossy O Heavy
O Lite

Application Settings

[ Lok Orienkation

el

Figure 5-89 Setting work preferences

« Building Style—see "Surface Finish" on page 5-21.
« Grid Style—see "Choosing the Support Strength" on page 5-58.
« Application Settings:
O Lock Orientation—see "Freezing Model Orientation" on page 5-41.

O Hollow—see "Hollow"—Filling Models with Support Material on
page 5-59.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:

> Open the Tools menu.

Iools =|Style = @) -

Grid
Snap ko Grid

Constrainks Setkings. ..

Section

Flane alignment 3

V' | Professional Mode

Language...

Options. ..

Define Colors, ..

Figure 5-90 Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:

1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change will
only take effect the next time you open Objet Studio—even though the
check mark next to the Professional Mode option appears immediately.

1 E The configuration changes wou hawve made will not take effect until the next bme vou run the application.
-

Figure 5-91 Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default
Settings

Automatic
Orientation

Automatic Zoom
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You can control the default settings of several Objet Studio features from the
Advanced tab of the Options dialog box.

To display the Options dialog box
> From the Tools menu, select Options.
or—

In the Objet Studio Commands menu o , click Options.

Options EI

Appearance Grid M anipulate Dizplay
Settings Advanced Troubleshooting

[ usto Zoam
Orient Objects Autamatically

[ 0K H Cancel ]

Figure 5-92 Options dialog box, Advanced tab

By default, when Objet Studio places objects on the build tray, it orients them
optimally, for the shortest printing time. If necessary, you can choose to
cancel automatic orientation each time you place an object on the build tray
(see "Automatic Orientation" on page 5-27). In any case, when objects are on
the build tray, you can change their orientation manually (see "Manual
Positioning" on page 5-29.)

To change the default setting so that Automatic Orientation is disabled:
> In the Advanced section of the Options dialog box, clear the check box.

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the zoom
level, as necessary (see "Zoom Options" on page 5-49).
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OpenGL Driver The OpenGL driver displays 3D graphics on your screen. There is normally no

Configuration reason to adjust its settings. If you suspect a problem with the way Objet
Studio displays objects, you can use the OpenGL Driver Configuration tool to
check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands menu © , click Options.
2. In the Options dialog box, display the Troubleshooting tab.

Options E|
Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

I OpenGL Driver Configuration...

[ 0K H Cancel ]

Figure 5-93 Access to OpenGL Driver configuration

The Troubleshooting tab is only accessible when Professional Mode is active
(see "Professional Mode Features" on page 5-69).

3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index) for
the window and the memory.

OpenGL Driver Configuration

Wwindow Pivel Format | Memary Pisel Format | Advanced

() Pixel Format 1D

@ Chooze Format | Option 1 3z
Calor Bits 24
Depinfits |32
Alpha Bits i

[ 0k ][ Cancel ]

Figure 5-94 OpenGL Driver Configuration dialog box
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If you want to display the values and change them, click [:I Alternately, you
can select Choose Format and change the values in this dialog box.

To
ID:

1.
2.

perform a test of the driver configuration and enter the suggested pixel format

Select Choose Format.
Click Test.
Objet Studio returns the recommended pixel format ID.

Objet Studio X

L]
\y Choose Pixel Format: 5

Figure 5-95 Recommended pixel format ID
Click OK.

In the OpenGL Driver Configuration dialog box (Figure 5-94), select Pixel
Format ID and enter this number.

Click Apply.
Display the other pixel format tab, and repeat this procedure.

Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you
work.

To view Objet Studio Help:

>

DOC-06810 Rev.B

On the standard toolbar, click # and then click Objet Studio Help.

Tools = Style - | (@)~

Chijet Studio Help )

Troubleshooting
Check for Updates
g About,..
Figure 5-96 Help options
You can also view information on the following subjects:
O Troubleshooting opens a list of error messages and their explanations.

O Check for Updates checks if you are using the latest Objet Studio
version.
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Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module
installed, and the features available with your license.

To view details of your Objet Studio installation:
> On the standard toolbar, click © and then click About....

Tools ~ Skyle ~| @~
Ohijet Studio Help

Troubleshooting

Check for Updates

Figure 5-97 Displaying Objet Studio details

About Objet The About Objet Studio tab shows the Objet Studio version number and basic
Studiotab information about your computer.

e] |

About Objet Studio | Materials Module I Feature License|

(IBJET

Obijet Studio Ver. 5.2

Copyright = 2013 Stratasys Lid.
All rights reserved.

For Applications Support: applications-inkjet @stratasys .com

Operating System:  Professional -Service Pack 1 (Build 7601}

Processor: Pentium Vs
Awvailable Physical Memory: 515 MB
System Resources: B4

Figure 5-98 About Objet Studio tab

Materials The Materials Module tab shows details of the material module installed.

Module tab

About Objet Studio

Materials Module | Feature License

Module version:  9.2.7.7
Module Date: 28.01.2013

Module Properties: Default

Figure 5-99 Materials Module tab

* Module version

If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.
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® Module date

If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the
date of the Objet Studio version.

* Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

Feature License The Feature License tab shows the Objet Studio features available with your
tab license.

Ahout Dbjet Studio | Materials Module | Feature License | Credentials

High Quality
High Speed
Digital b aterial
M aterials
Drigital materials
Mixed tray

Figure 5-100 Feature License tab

Click ¥ to expand the details for each feature.
» Modes shows the printing modes available.
See "Printing Modes" on page 5-52.
» Materials shows basic model materials available.
« Digital Materials shows the digital materials available.

» Mixed Tray shows if your license enables printing a build tray containing
objects, using a different model material for each.
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Monitoring and Managing Print Jobs

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on client

workstations and on the computer connected directly to the 3D printer—the
server workstation.

« Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.

Note: Ifthere are several PolyJet printers on the local network, client
computers can connect to any of them, but only one at a time.

» Objet Studio installed on the computer directly connected to a specific 3D
printer (server), displays the queue and status for all jobs sent to that 3D
printer by the server and by all client computers on the network. It also
allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.

QE{ If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any PolyJet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.

Job Manager = The Job Manager screen on the client and server workstations looks
Screen identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.

L+ ’ ; -
JobManager ) = = i e
Ribbon
Jobs Quese —] °° [
' Available
ME5 OUICEs
Print Progress —{ | e
B B
- g il - | Materials
Print History— = =5 # =5 I [ == | S consumption
2 , ——Tray Preview
Waste status ] ‘{L !I ¥

Figure 5-101 Job Manager screen

The Job Manager screen is divided into panels:
» Jobs Queue
« Printing Progress
 History
« Available Resources
» Material Consumption
« Tray Preview
» Waste
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Jobs Queue

Printing
Progress

History

Available
Resources

Material
Consumption

Tray Preview

Waste

On the server, the Jobs Queue lists the last 15 jobs sent from client computers.
On client workstations, it lists jobs sent from that computer to the server.

Information for each of the queued jobs is displayed, including the job status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be continued
(Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was placed in
the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing The 3D printer is readying itself for printing: the cover locks,

print heads warm up and are put in starting position, UV
lamps are turned on, and the build tray level is adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:

« Owner—the computer that sent the job
* Build Time—the estimated building time for the job

» Model Consumption—the amount of model material required to complete
the job, and the amount actually used till now

« Support Consumption—the amount of support material required to
complete the job, and the amount actually used till now

 Printing Mode—HS=High Speed, HQ=High Quality, DM =Digital Material

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Available Resources panel contains graphic indicators that show the
amount of available printing materials remaining in the printer.

e Actual—the amount of material used till now

* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see "Additional Server Features" on page 5-81).

The amount of waste appears when the cursor is over the Waste display.

1Objet Studio displays the weight of the printing materials in both containers as long as each container contains more than 100 grams of

material. The weight under 100 grams is not calculated and displayed. However, if a container contains less than 100 grams of material,

the printer uses it—as long as the material in the other container weighs more than 100 grams. In any case, the weight of each container

is displayed in the printer application.
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Setting the When you open Objet Studio for the first time in a client installation, you are
Remote Printer prompted to connect to a server computer that sends jobs to a 3D printer. To
Connection do this, the server computer must be operating and connected to the local

(Client Mode)  network.

To set (or change) the connection to the server-computer:

>
On the Job Manager ribbon, in the 3D Printer group, click ===,

2. Enter the name of the server computer or its IP address, or click Browse
to find and select it.

3. Click OK.

o |
?_,,J == ¥ j‘ iJ
e, sy |

T

Specify Server Computer name/|P address.

Browse...

Use ‘Unknawn' for off-line mode.

Figure 5-102 Printer Server Connection dialog box
Job Manager The Job Manager ribbon has three icon groups:
Commands 3 3D Printer
O Queue
3 Job
P ¢ FUYYeOBESE
Connect Motifications | Top Up Down Bottomn | Restart Stop Resume Delete iew  Edit

30 Printer Queue Job
Figure 5-103 Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example, since
you cannot stop printing a job that is not being printed, the Stop command is
disabled when the printer is idle.
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The following operations are available on the Job Manager ribbon:

Group | Ilcon | Purpose
3D @ | Client: Sets the server connection. See "Setting the Remote Printer Con-
Printer | cennest | nection (Client Mode)" on the previous page.
Server: Sets the printer connection. See "Setting the Printer Connection”
on page 1-1.
= Configures options for printer alerts. See "Configuring User Alerts" on
Motficat page 5-80.
Queue | 3 Server: Moves a job to the head of the Jobs Queue.
| Client: Disabled.
See "Jobs Queue" on page 5-76.
= Server: Moves a job to a higher position in the Jobs Queue.
= Client: Disabled.
See "Jobs Queue" on page 5-76
7 Server: Moves a job to the bottom of the Jobs Queue.
ettem | Client: Disabled.
See "Jobs Queue" on page 5-76.
vl Server: Moves ajob to a lower position in the Jobs Queue.
™ | Client: Disabled.
See "Jobs Queue" on page 5-76.
Job #. | Server:
Rastint + Forajobinthe Jobs Queue—Prints it again (from the beginning).
* Forajobinthe History list—Moves it to the Jobs Queue for printing.
Client: Disabled.
See "Restarting Jobs" on page 5-83.
(%) |Server: Stops ajob in progress.
92" | Client: Disabled
e Server: Continues printing the current job from the point where printing
rears | Stopped.
Client: Disabled.
See "Resuming Jobs" on page 5-83.
%x Removes the selected job from the queue.
L\;:—ll:
x5 Refreshes the image of the selected job in the Tray Preview display.
S
? Opens the Tray Settings screen and displays the tray. For deleted jobs,
-

this enables you to make changes before printing.
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In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Stop S = Delete
» * |
Edit——1—% 2 B~ Resume

Export packedjob Schedule

Figure 5-104 Icons on pop-up toolbar (server)

¥ Delete

-

-

Edit

Figure 5-105 Icons on pop-up toolbar (client workstation)

Note: Mosticons and menu commands are only enabled when a job is
selected.

When you position the cursor over an item, a tooltip displays the name of the
command.

Job = Tools = Stwle -

3 Stop...

¥ Delete Job..,

Show 3dProgress

& Export ...

Figure 5-106 Job menu options (server)
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Configuring Objet Studio can alert you (and others) to the status of jobs sent to the server
User Alerts for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

« The level of model or support material is low.

« The job was interrupted.

« The job was completed successfully.
To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular

phone service must support the transmission of e-mail messages by SMS.
Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

b
it

1. On the Job Manager ribbon, in the 3D Printer group, click =

Notifications El
Sound Alert
@ () Voice Messages ) P Spesker
2

Rieport to Printer

HP Deskl et 330C/332C/935C

Report to e-mail

Add Recipient.

Fiemove Riecipient]

Add Recipient.

[¥] Repart via SMS

A RenindMe |15min v | Before Cartiidges Emply

S MlRenindMe (1000 | Before Catiges Emply

0K Cancel

Figure 5-107 Notifications dialog box (server)

Notifications E]

Sound Alert
@ () Voice Messages () PC Speaker
7
[] Repot ta printsr
Report ta e-mail
[ Repoit via SMS
0K Cancel

Figure 5-108 Notifications dialog box (client workstation)
2. Set the desired reporting options.
3. Click Details.
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Select Events to report on;
Successful job finish
Job interuption

End of Material reminder

[ Ok ] [ Cancel ]

Figure 5-109 Event selection for alerts
4. In the Reports Events dialog box, select the alert events and click OK.
5. In the Notifications dialog box, click OK.
Printing from If there is a job in the Jobs Queue, it is sent automatically to the Stratasys

the Jobs PolyJet printer—as long as it is on, there is a connection to the printer, and
Queue the printer is on line.

Chapter 6 describes starting and operating the printer.
Additional Objet Studio on the printer server includes the following additional features:
Server

« "Extended Tray Preview"

« "Editing Jobs"

« "Restarting Jobs"

« "Resuming Jobs"

+ "Scheduling Jobs"

« "Exporting Jobs (objzf)"

« "Modifying the Job Manager Screen"

These features are described below.

Features

Extended Tray Preview

In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
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2. Click the Tray Preview pane.

LR L=t ShE ] L DS

e — — _.”.-;

Figure 5-110 Job Preview

O To change the tray magnification, turn the mouse wheel.

O To view the tray from a different perspective, click the relevant icon.
O To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:

1. Double-click on the object you do not want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5stl

|Info | Options | Buid |
Exclude from Build

0Objet Studio

' : Are you sure you want to exclude this model from build process?
L

[ ‘es ] [ Mo ]

Figure 5-111 Excluding a model from the build
4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display objects
as they are printed, layer by layer. This enables you to visually monitor
printing progress on the computer screen.

To display printing progress in the Tray Preview pane:
> From the Job menu, select Show 3dProgress.

%( This option uses additional system resources.
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Editing Jobs
You can open jobs in the Jobs Queue for editing.

To edit a job:
1. Select the job.

2. Click the Edit icon ex .

The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. Edit the job.

L
.‘.}.
4. On the Tray Settings ribbon, click # s,
The status of the job in the Job Manager screen changes back to
“Waiting.”

Restarting Jobs

You can restart jobs from the Jobs Queue and the History list.
Torestart a job:

1. Select the job.

.5.
2. Click the Restart icon F==t |

The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to continue
printing the job from the point where printing stopped.

When resuming a print job, the printer tray does not move. The printer
expects Objet Studio to send the slice from where the stoppage or failure
occurred.

To resume printing:
1. Select the job.

=
2. Click resee
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and early
morning hours.

To schedule a job:

1. Select a job in the Jobs Queue, and click & on the pop-up toolbar.
2. In the Scheduler dialog box, set the Start Date and Start Time for the job.
Click on the Start Date arrow to open a calendar.

s x|

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
Bl  apizono

Sun Man Tue 'Wed Thu Fri Sat (=
12 3

4 5 B 7 B 3 10
@i 12 13 14 15 16 17
18 13 20 21 22 23 24
5 % 27 28 29 30 J

— ToToday: 471172010
Figure 5-112 Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

% For an explanation of objzffiles, see "Saving Build Trays" on page 5-62.

DOC-06810 Rev.B

To export a print job:
1. Select a job.

2. On the pop-up toolbar, click ®.
3. In the Save As dialog box, select a folder.
4. Click Save.

Modifying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

« the Jobs Queue panel

« the Time panel
« the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

« Click again to display the panel.
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Figure 6-1 The Objet1000 Plus 3D Printer

Starting the Printer

Caution

« Do not attempt to operate the printer before being trained by a Stratasys
Customer Support representative.

« Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2 Main power switch
Turning on the printer also turns on the two built-in computers.
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2. After the printer-control computer boots, log in to Windows and launch
the printer-control program:

O On the printer-computer desktop, double-click the Objet1000 Plus
printer icon.
or—

O From the Windows Start menu, select (All) Programs > Objet >
Objet1000 Plus.

% A HASP plug containing a valid product activation key is required on the
printer computer. This is supplied during printer installation or upgrade. If the
application does not open and a HASP message appears, contact your
dealer or Stratasys Customer Support.

3. After the printer-server computer boots, launch the Objet Studio program.

To switch the keyboard, mouse and monitor between the printer-control

computer and the printer-server computer, press Scroll Lock twice, then
press Enter.

The printer-control computer displays the main printer interface. All
monitoring and controlling of the printer is done from this interface.

e e ——
"‘" Stratasys

Printer mode

A

Model material

Eurrentact'r-,"rty\_ e I containers (lefright)

Waste containes =—— Supportmaterial
(leftiright) containers (letfright)
Dis playtoggle gy ORIET 1000
button

/On”nﬂ]’ﬂminﬁ bution

Stop button Pause button

Figure 6-3 Objet1000 Plus interface

QE{ One monitor displays both the computer running Objet Studio and the printer
server computer.
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Loading Model and Support Containers

Objet1000 Plus printers use four containers of Model material and two
containers of Support material, each weighing 18 kilograms when full. A
graphical representation of the containers loaded and their current weight
appears in the printer interface (see the figure on the previous page).

% The printer uses RFID technology to automatically identify containers of
printing material. For this purpose, an RFID module is part of the printer
hardware. Tampering with this module will render the printer inoperable and
may void Stratasys warranties and service contracts.

Important: [f you need to replace the Model material currently installed with
another type, see "Changing the Printing Material" on page 6-13. Otherwise,
make sure to replace the Model cartridge with one containing the same type of
material.

To load Model and Support material:

1. On the side of the printer, pull open the doors of the storage
compartment.

2. If you are replacing a material container, disconnect it from the feed tube.
Then, grasp the handle and pull the container out of the printer.

3. Load Model and Support containers into their respective compartments.

Lift full material containers carefully, using both hands. It is
recommended that you use a lifting handle similar to the one shown here.

Figure 6-4 Material container lifting handle

4. Connect the material feed tube to the container.

You should hear a clicking sound when the connector is securely attached
to the container. Make sure that the connector is secure.

5. Check the printer interface to make sure that the new container is
detected and that its weight is displayed (see the figure on the previous

page).
6. Close the storage-compartment door.
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Tips about loading and replacing material containers:

You can load partially used containers, provided that they contain more than
100 grams of material.

You can replace material containers either before or during printing.

If printing stops for an extended time before you replace a material container,
the printer may go into Standby or /dle mode. If this happens, see "Resuming
Production After Printing has Stopped" on page 6-10.

You can replace a partially used container to avoid the need for replacing it
during printing.

The container type is automatically detected by the printer. If you replace a
container with one that has different Model material, a message appears
recommending that you run the Material Replacement wizard to flush out the
old material.
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Producing Models

Preparing the
Printer

DOC-06810 Rev.B

Models can be printed after they are arranged on a virtual build tray in a 3D
printing application. Two such applications are available for preparing trays
for printing on the Objet1000 Plus printer:

« Objet Studio

» GrabCAD Print

For information about preparing model files for printing, see the relevant
documentation—

« "Using Objet Studio" chapter in this user guide or Help in the Objet Studio
application.

¢ GrabCAD Print online documentation.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
"Pattern Test" on page 6-24).

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not,
remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

The build tray for the Objet1000 Plus printer is removable, which aids in
the removal and handling of printed models. Make sure that the build tray
is installed when preparing the printer for producing models.

Caution

Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.

2. Check that the print heads and roller assembly are clean. If not, clean
them before printing, especially if the print job is longer than 100 hours.

3. Make sure that there is sufficient Model and Support material loaded, as
indicated on the printer interface (see the figure on page 6-3). You may
want to replace the containers of Model and Support material currently
loaded in the printer to avoid the need for replacing them during printing,.

For installing material containers and replacing empty ones, see "Loading
Model and Support Containers" on page 6-4.

For changing the type of Model material currently loaded, see "Changing the
Printing Material" on page 6-13.
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You can monitor printer status by switching the printer interface display. To
do this, click the display toggle button on the printer interface screen.

M stratasys

Temperature behind
print bock

\
bt
Temp. of each

Supporthead

Temperaturein front
ofprint Hock

Temp. of each Model head

SupportModel materal in

Chamber temp. print-block resenvair

Leftand right LIV
lamps | - S}lstemvacuumlwd

E?Chﬂ-usltﬂ.irﬂgﬁ/ e \Pre.hEﬂtIHEIDfSJDDDrt&

Model matenal

|
)
N
__NN
=1}

Displaytoggle
button

Printersetto offline mode
{red)

Figure 6-5 Printer status

Starting To begin printing:

Printing > On the printer interface, click the red button to switch the printer to
online mode.

The color of the button changes from red to green (see the figure on
page 6-3). If there is a job in the Job Manager queue, it is sent to the
printer.

When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 6-22.) Maintenance notifications
can be disabled/enabled from the Options menu.

Before printing a job, the software executes a set of hardware and software
tests to ensure optimum printing results. In the printer interface, the printer
mode changes from Idle to Pre-print, as the printer’s components prepare
themselves for production:

« The print block is heated.
« The UV lamps are powered and they warm up.

When printing begins, the print manager program sends seven slices to the
printer-control application. This is the standard buffer between the print
manager and the printer. As each slice is printed, as a layer of the models on
the build tray, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model and
Support material in the supply containers, printing proceeds automatically
until the job is finished.
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%{ During printing, the server computer must remain on and it must
communicate with the Objet1000 Plus printer. Do not log-off Windows until
printing is finished.

The Objet1000 Plus printer uses one or two Model-material containers and
one Support-material container to produce models. If additional containers
are installed and they are not immediately needed for printing, the printer
interface indicates this (see "Printer Interface Color Key" below).

Printer The background colors in the printer indicator fields tell you at a glance
Interface whether or not the value or item is suitable or ready for printing.
Color Key » Green—suitable/ready for printing

For example, in Figure 6-5 on the previous page:

O Heads Liquid—The level of Model and Support material in the
print-block reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the
acceptable range.

O Evacuation—The flow of exhaust air from the printer is OK.

O Pre-Heater—The Model and Support resins need to be heated before
being supplied to the print block. The temperature has reached the
acceptable range.

» Red—not suitable for printing (or indicates a warning)
For example, in Figure 6-5 on the previous page:

O Ambient—The ambient temperature of the printing chamber is not
within the acceptable range.

« Blue—not ready
For example, in Figure 6-5 on the previous page:
O UV lamps—The UV lamps are not on.

O Heads (°C)—The heads have not reached the temperature required for
printing models (in printing mode).

O Pre-Heater—The Model and Support resins need to be heated before
being supplied to the print block. The temperature has not yet reached
the acceptable range.

The color of the material containers displayed in the printer interface
indicates which containers are active for the current (or next) print job.

For example, in Figure 6-3 on page 6-3:
» Blue—active container
« Gray—reserve container
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Printing The printer interface screen changes when you send a print job to the printer,
Indicators if the printer is on line:

« The mode changes from Pre-print to Printing.

« The specific activity being performed is shown in the “current activity”
field.

« Current job-printing information is displayed.

« The printing progress bar is displayed.

« The Stop and Pause buttons are enabled.

When the weight of a container drops below 100 grams, the display of the
material level in the printer interface is red.

| #'stratasys 07 Jen 2003 165F |

. L i
Printer mode
. ) I Print Time 00:20:01 f
Jobinformatan T
Current activity !
—

Jobinfomation

Progress bar

=¥ 0BJET 1000

Stop buton Pause button

Figure 6-6 Printer interface during printing

DOC-06810 Rev.B 6-9



Objet1000 Plus User Guide 6 Operating and Maintaining the Objet1000 Plus 3D Printer

Resuming Production After Printing has Stopped

If the printing process is interrupted, Job Managerthe print manager stops
sending slices to the printer. This can happen, for example, if the printing
material runs out in the middle of a print job, and you do not replace the
empty container immediately. After the printer changes to Standby or Idle
mode, you need to resume printing from the print manager (in Objet Studio
or in GrabCAD Print).

After printing stops, the printer goes into Standby mode, when heating of the
print heads is reduced. About 10 hours later, the printer goes into /dle mode,
when heating of the print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see the figure on page 6-
3)-

The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Manager screen of Objet Studio, or in the GrabCAD Print screen,

click the Resume icon— ##=um= or E]

4. In the job-preparation application, make sure that the correct slice
number is entered in the dialog box.

Continue from Slice: |£|

163

[k | Cancel |

Figure 6-7 Slice confirmation in Objet Studio

Print Job 1l-Impeller GrabCAD

| ast printed slice 1&8

Figure 6-8 Slice confirmation in GrabCAD Print
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Printer mode

Print Time 00:00:43

Height 5.29mm of 77.88mm

Slice 168 of 2782 (6.8%)

Previous job last slice Last slice printzd

Figure 6-9 Printer interface after interrupted printing

5. If, for any reason, the correct number does not appear in the dialog box,
enter the number and click OK.

You cannot continue printing the model if:

« The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

« There was a relatively long interruption in printing, even if the “last slice”
and “continue from slice” indicators are correct. The part of the model
already printed may deform or shrink, and there might be a visible
difference between it and the newly printed part. The effects of a printing
stoppage on a model depend on the model size and structure, Model
material used, ambient temperature and the length of the stoppage.
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If you cannot continue printing:

1. Cancel the job in the printing application (Objet Studio or GrabCAD
Print).

2. Remove the partially printed model from the build tray.
3. Resend the job to the printer from the printing application.
e

O In Objet Studio, click Fesume=,

-
3 In GrabCAD Print, click .

%{ You can stop printing from the printer interface or from the printing application
(Objet Studio or GrabCAD Print).

* After clicking the Stop button in the printing application, you can resume
printing from the printing application or from the printer interface.

» After clicking the Stop button on the printer interface, you can resume
printing only from the printing application.

« After clicking the Pause button in the printer interface, you can resume
printing only from the printer interface.
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Changing the Printing Material

Before producing models using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print
block and feed tubes.

% When changing the type of Support material, run the Material Replacement
wizard and the Head Optimization wizard to ensure quality printing results.
(After changing Support material with the wizard, Head Optimization is
required before printing models.)

% You should carefully plan printing models with different Model materials to
avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are replacing
one or both Model cartridges.

To replace the printing material with the wizard:
1. Start the Material Replacement wizard from the Options menu.

aF Gt s Ty Lipse P, P
i s o Pty P

LSt ,, 1 dun2013 84 |
e e P et L
e e

i St ]

Bl I N, kALl ] 0 g /

Manterars Loonkors
Coloc Soree Dets

Previous |ob last slice: 0

||||||

Figure 6-10 Starting the Material Replacement wizard
2. In the opening screen, click Next.

3. If the printer doors are not closed, a screen appears, prompting you to
close them. Confirm this and click Next.
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Material Replacement Wizard

Material Replacement Options

Printing mode
® Single matenal pnnsing meds (HO, HS)

O Mmple materals pranting mode (DM

Required materials
Mote: Caridge posioning in material cabinet is determined automascally

VeroWhile W

[] Bleah carindges

Flushing cyche

& Full
) Econneny

‘Full’ previdas you with s=act color immadiataly
‘Economy” enables a faster matenal replacement grole

i- 2 Hm] Fr— Seitinga ] [ b 4 Ean'.ﬂ] Bt 3=

Figure 6-11 Material replacement options

In the Material Replacement Options screen, you select the settings that
determine how the wizard replaces material currently in the system with
newly loaded material.

4. Choose whether you want to produce models in Single Material mode or
in Digital Material (“multiple-materials”) mode.

Single Material mode
Four print heads are used to print, using one Model material.

O This mode is required to produce build trays with the High Quality
setting, and to produce trays with the High Speed setting, using only
one Model material.

Digital Material mode
Each of the Model materials loaded is used in two of the print heads.

O If only one of the Model materials is required for printing, models are
produced using two print heads. This makes it unnecessary to replace
the other Model material.

O If Model-material substitution is allowed, the printer produces trays
with the High Speed setting using a mixture of Model materials (see
"Model Material Substitution" on page 5-55)

5. In the Required materials section of the wizard screen, select one or more
replacement materials containers.

6. For Model materials, select Both if you need to load two replacement
containers.

Loading one replacement container is more economical because it
potentially requires less flushing of material currently in the system.
However, when one container is not sufficient, loading two containers
enables continuous printing until the print job is completed. When one
container empties and the other one is being used, you can replace the
empty container with a new one.
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7.

8.

For Support material, select Both if you need to load two replacement
containers.

In the Flushing cycle section of the wizard screen, choose how thoroughly
you want to flush out material currently in the system:

O Economy. This cycle can be used when replacing a light-colored Model
material with a darker material (such as TangoBlack™ or VeroBlack™)
or if the exact color of the printed models is unimportant. Use this
cycle when replacing cleaning fluid with any Model material.

The wizard flushes the system with the minimum amount of material
needed to ensure that models have the mechanical properties of the
new material.

O Full. Use this cycle when the printed models must have the exact color
of the new material.

The wizard thoroughly flushes the feed tubes and print heads needed
for printing, based on your selections in the previous screens.

There are additional settings that you can select for special purposes (see
"Advanced Settings"). If necessary, click Advanced Settings before clicking
Next.

0.

Click Next to begin the material replacement process in the printer.

The positioning screen appears, showing you the new location of the
containers in the materials compartments.

Hatrral Rrplacemernt Wirsrd
- Cartridge positioning and process progression

-ﬂ Insert #oe nevw rabotia] cartndge s shown below, and b Stan
1 ﬂ‘ﬂ Ledt Right
L W2 VeroBlack wr VeroBlack %
H1 VeroWhite v VeroWhite
Supoait e FullCure7 05
_ e |
Replacoment progress
o | 2] |
' Stratasys
Kiwes |  <over] |

Figure 6-12 Container placement

Symbols:

¥ The correct container is in this position.

“ No container (or the incorrect container) is in this position.

' The container in this position has insufficient weight to complete the

material replacement process.

¥ The expiration date of the container in this position has passed.
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10. Replace material containers as necessary, according to the instructions in
the wizard screen.

% Make sure to securely attach the cap to partially used material containers
when not loaded in the printer. If not properly capped, exposure to UV light
could cause polymerization (curing) of the material, making it unsuitable for

printing.

11. Click Start.
12. Read the warning message, and click OK.

%{ If you continue, you must complete the material replacement process before
you can produce models. To replace material containers at another time, click
Cancel. If you continue (by clicking OK) and you do not complete the process,
you will need to run the wizard again before producing models.

Matenal Replacement Wizand

Material replacement completed
Prrbar's cusiant Sonbous st

7y »

M2 VeroBlack VeroBlack
M1 VeroWhite VeroWhite
Suppont FullCure7 05 FullCure7 05

Printing mode: Digital materials (DM)
“ Stratasys

Irmportant: Afrer closing this wizard, cean the area around thi purge unit.

| | Lone

Figure 6-13 Final wizard screen

13. In the final wizard screen, click Done.

The printer-control application is automatically updated, and the interface
displays the new material(s). The interface in the job preparation
application is also updated, and it displays the new material(s).

14. Inspect the area around the purge unit and clean it, if necessary.

& Caution

Dispose of all material containers in accordance with all applicable laws and
regulations.

% Empty material containers can be used as printer-waste containers.
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Advanced The Advanced Settings dialog box enables you to configure the Material
Settings Replacement wizard for special purposes. If necessary, click Advanced
Settings in the Material Replacement Options screen before clicking Next.

Matenal Replacement Wizand

Advanced Settings
Cartradge positioning”
i Automabc slot selacton
" Marusl slol selection
This selection sppies ko this vss of the wizand only.,

“"Stratasys I “Fiush sgei opsons
7t | _coce | [oem> ]

Figure 6-14 Advanced Replacement settings

Some materials cannot replace certain other materials. If you attempt to do
so, the wizard notifies you.

Positioning By default, Automatic slot selection determines the best positioning for the
material containers, based on materials currently in the system. This ensures
minimum flushing of materials currently loaded. If there is a special need to
load material containers in certain docks in the printer, select Manual slot
selection.

After clicking Apply, the Material Replacement Options screen appears, but
now, each material selection box corresponds to one of the container
positions in the printer.

ML MR MZL MZR

Hacunrnd r|'.|'|"|.1|-x f In‘dkam Manua.l

" - —p " Placement Mode
[r—— =] | [vernBiack = -
Both carvidges [R_n] | ¥ Bothcarvidges FA R
L
R

Figure 6-15 Manual cartridge placement
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Additional The flushing cycle you select in the Material Replacement Options screen
Flushing Cycles determines how thoroughly to flush out material currently in the system.
After selecting the Economy cycle and completing the wizard, you might
decide that you require a more thorough flushing, to ensure accurate model
color. Or, you may notice that printed models are not satisfactory because
they contain traces of the previous material. If so, you can flush out more
material, so that the next models will be printed with pure material.

To perform additional flushing cycles:

> In the Advanced Settings screen, select "Flush again" options and click
Apply.

The Material Replacement Options screen appears, where you can select the

material(s) you need to flush again.

Keeping the Printer in Idle Mode

Between printing jobs, the Objet1000 Plus printer can be left unused for up to
one week. If the printer will not be used for more than a week, use the
Shutdown wizard to automatically perform the procedures that must be done
before turning off the printer (see "Shutting Down the Printer" on the next
page).

When the printer stops producing models, the printer software automatically
reduces the temperature of the print heads, as follows:

After printing stops Mode Change in heating of print heads
first 15 minutes Standby 1 no change

next 10 hours Standby 2 heating reduced (to room temp.)
after Standby 2 Idle heating stopped

Note: The printer mode is indicated in the upper left of the printer interface
screen (see the figures on pages 6-3, and 6-9).

If, after printing a job, you know that the printer will not be used for 10 hours
or more, you can immediately turn off the heating of the print heads by
putting the printer into Idle mode.

To put the printer into Idle mode:

> From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Objet1000 Plus
printer application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this mode—
with the cover closed—for up to a week. For longer periods, shut down the
printer by running the Shutdown wizard (see Shutting Down the Printer,
below).

DOC-06810 Rev.B 6-18



Objet1000 Plus User Guide 6 Operating and Maintaining the Objet1000 Plus 3D Printer

Shutting Down the Printer

You only need to shut down the Objet1000 Plus printer if it will not be used
for a week or more. Otherwise, the printer can remain on, in Idle mode.

%{ The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Do not attempt to shut down
the printer by simply closing the computer interface (the printer-
control application), and never disconnect power to the printer
before completing this wizard.

& Caution

Not using the printer for an extended period without first running the wizard
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose
between a short shutdown procedure, and a more thorough procedure.

« Up to 10 days: The wizard empties the print block of Model and
Support material, to prevent leaks. This takes about 10 minutes.

« More than 10 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 35 minutes, and you must
be present to load a container of cleaning-fluid when instructed.

To run the Shutdown wizard:

1. Start the Shutdown wizard from the Options menu.

Shutdown Wizard

Shutdown Wizard

Qﬁ This wizard controls the processes necessary for shutting

down the printer.
Fress 'Next' to continue or 'Cancel' to quit.

Stratasys

“ Help | X LCancel | Ereviousl i

Figure 6-16 Shutdown wizard, opening screen
2. Click Next.
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3. Select the option corresponding to the length of time that the printer will
not be used—Iless or more than ten days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

Shutdown Wizard

Select Action

Shutclown the printer for:

" More than 10 days [requires cleaning-fluid cartidges).

-/ stratasys

4 Help XK Cancel |

Figure 6-17 Shutdown options

4. In the next screen, verify that the tray is empty and click Next.
The shutdown procedure begins.

Shutdown Wizard

)

Shutdown in Progress

<V stratasys

Figure 6-18 Shutdown progress
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5. When the final wizard screen appears, close all open programs on both
computers, and shut down the computers.

Shutdown Wizard

Wizard Completed

L

You may now shut down the printer computer and turn off
power ta the printer.

Stratasys

Figure 6-19 Final Shutdown wizard screen

6. After both printer computers shut down turn off the main power switch at
the back of the printer (see Figure 6-2 on page 6-2).

DOC-06810 Rev.B 6-21



Objet1000 Plus User Guide

6 Operating and Maintaining the Objet1000 Plus 3D Printer

Maintaining the Printer

Routine
Maintenance
Schedule

DOC-06810 Rev.B

Performing routine maintenance tasks is essential for getting satisfactory
results from Objet1000 Plus 3D printers. Perform the tasks at specified

intervals.

Frequency

Task

For More
Information

Before printing

Clean the UV lamp lenses.

Before / after printing

Check the UV lamp overheating indicator.

See "UV Lamp
Check " on
page 6-24.

Before / after printing

Routine cleaning of:

* print heads

+ roller surface

* wiper

* build tray and surrounding area

"Cleaning the
Print Heads,
Roller and
Wiper" on
page 6-27.

Weekly

Clean the purge unit waste collector.

See step 13 of
"Cleaning the
Print Heads,
Roller and
Wiper".

Weekly

Perform the Pattern test.

See "Pattern
Test" on
page 6-24.

Weekly

Clean the roller waste collector.

See "Cleaning
the Roller
Waste Collector
and Inspecting
the Roller
Scraper" on
page 6-30.

Every 300 hours of
printing (A reminder
message appears.)

Calibrate the UV intensity.

See "Testing
and Calibrating
the UV Lamps"
on page 6-58.

Every 300 hours of
printing

Optimize the print heads.

See
"Optimizing
(Calibrating)
Print Heads" on
page 6-40.

Every 500 hours of
printing

Replace the wiper.

See "Cleaning
the Print
Heads, Roller
and Wiper" on
page 6-27.
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server computer.

Frequency Task For More
Information
Every 700 hours of Replace the roller pump tubes. See "Replacing
printing the Roller
Waste Tube"
on page 6-61.
Monthly, and after Check the alignment of the print heads. See "Aligning
replacing print heads the Print
Heads" on
page 6-36.
Monthly Clean debris from the Z-axis shaft with a
vacuum cleaner.
Monthly Inspect the exhaust system (duct, fan,
connections).
Monthly Calibrate the load cells. See
"Calibrating the
Load Cells" on
page 6-64.
Monthly Restart the printer computer and the

2500 hours of printing

Every two years or every

Preventive maintenance visit by service
engineer.

Contact your
Stratasys
service
provider.

DOC-06810 Rev.B
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UV Lamp A heat-sensitive label is fixed to the UV lamp covers as a warning against

Check overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call
your service provider. As a precaution, it is recommended that you check the
label before and after printing.

Marmal

Cverheating
problem

Figure 6-20 Heat-sensitive label on UV lamp cover

%{ If the UV lamp continues to overheat, and the temperature around the lamp
reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that this
occurs, the printer cannot be used until it is serviced by an authorized service
engineer.

Pattern Test The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the print
heads. Make sure, therefore, that you perform this test weekly, and whenever
you suspect a printing problem.

To perform the pattern test:

Make sure that the build tray is empty.

Prepare a sheet of pink paper, A-4 or Letter size.

In the printer, tape the pink paper to the surface left of the build tray.

B @b

Press F3, or open the Options menu and select Pattern Test.
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File” Options Help

Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence F4
Pattern Test F3

Dynamic Nozzle test

Wizards 4
Built In Tests... Ctrl+Alt+B
Maintenance Counters... Shift+Ctrl+C
Collect Service Data F2

Figure 6-21 Selecting Pattern Test
5. Click Yes in the Confirm dialog box to begin.

Confirm rz|
=2

[ Yes l [ Mo ]

Perform Pattern Test?

Figure 6-22 Pattern Test confirmation
6. If the build tray is not clear, click No in the following dialog box.

Confirm f'5_<|

y  Is the build tray clear?
\_t/ (If you didk 'NO', the tray will be lowered.)

[ fes l [ Mo ]

Figure 6-23 Build tray (Z) level adjustment
This lowers the build tray, so that models on the tray are not damaged.
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The printer prints a series of lines on the test paper (see next figure).

LRTHRRTTAATTAYTIARIY
T

Figure 6-24 Sample Pattern Test

7. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area, indicates
that the quality of printing when producing models will be poor. If this is
the case, see "Improving Print Quality" below.

Note: Acceptable model quality is subjective, and depends on the type and
scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.

Improving If you suspect that print quality is poor, perform the pattern test (see "Pattern
Print Quality =~ Test" on page 6-24). If the results are poor, use the following procedure to
improve print quality.
If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the wiper
removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads, Roller and
Wiper" on the next page).

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left
on them.

2. Perform the purge sequence.
3. Perform the pattern test.
If the results of the pattern test are still poor:

> Optimize the print heads and replace faulty print heads, if necessary (see
"Optimizing (Calibrating) Print Heads" on page 6-40).
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Cleaning the
Print Heads,
Roller and
Wiper
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Regular inspection and cleaning of the orifice plates on the bottom of the
print heads prevents print nozzles from clogging. Cleaning the roller and
wiper are also important for maintaining quality printing. A wizard adjusts
printer components to enable access to these key areas, and it guides you
through the cleaning procedure. To maintain the printer in optimum
condition, run the wizard after every print job, when you remove the model
from the build tray. This procedure takes about 20 minutes.

To clean the print heads, roller and wiper:

1.

Prepare—

3 isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves

O a supplied cleaning cloth or equivalent

O a mirror

Start the Cleaning wizard from the Options menu.

TF 30 bo Tray Upper Positon FS
f'St  comruwpsposton e
Wi Fr
Gato Head Inspection F3
0 bo Tray Lower Postion FIO

Purge Sequence F

Palbam Test Fi

Material Replacaimanl
Al 4B Haad Filing Calloration

Built In Tests..,

Haching Cparations
Mainbanance Counters. .,

LWL Riepilsc ermsnt
Colkect Servioe Data Fz -

Head Aigrment
Haad Oplimizaton
Liosd Cell Calbration
Shukdoesn

Previous job last slice: O

Figure 6-25 Options > Wizards menu

Make sure that the build tray is in the printer, and close the printer doors.

Confirm this in the wizard screen and click Next.

Cleaning Wizard

Check Printer

Confirm before continuing:

[ The build tray is inserted.

— [7] The doors are clased.

< stratasys

<72 Previous Mext 2=

Figure 6-26 Preparation check

The printer moves components to the cleaning position.
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4. When the following screen appears, open the printer.

Cleaning Wizard

Check Printer

|
(E 2! Canfirm befare cantinuing:
. The print heads are clean.

— The wiper blade iz clean.

The roller waz manually rotated and cleaned.

Stratasys

x Lancel

Figure 6-27 Wizard screen during cleaning tasks

& Warning: Hot Surface
' " The print head orifice plates (bottom surface) may be hot. Do not touch them
with your bare hands, and proceed with caution.

5. Place the mirror on the build tray.
6. Put on the gloves.

Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.

7. Soak the cleaning cloth with alcohol.
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8. Clean the orifice plates, with a back-and-forth motion. Use the mirror to
make sure that you have removed all of the residue material.

Figure 6-28 Cleaning the heads

9. After cleaning the print heads, clean the entire roller surface, by rotating it
as you clean.

10. Clean the glass lens on the UV lamps.

11. Open the service window on the left side of the printer to access the
wiper.

12. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.

13. Remove any pieces of waste material collected in the purge unit. If
necessary, remove the waste collector to clean it. Wipe the rubber seal.

Figure 6-29 Purge unit waste collector
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Cleaning the
Roller Waste
Collector and
Inspecting the
Roller Scraper
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Note: When returning the waste collector to the purge unit, make sure to insert it
as shown.

14. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

15. When you have finished cleaning, select the confirmation check boxes in
the wizard screen (see Figure 6-27) and click Next.

16. Remove the cleaning materials from the printer and close the printer
doors.

17. Select the confirmation check boxes in the wizard screen and click Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

f Cleaning Wizard
. Wizard Completed
Stratasys
|

Figure 6-30 Cleaning wizard—final screen
18. Click Done to close the wizard.

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow into
the printer.

To clean the roller waste collector:

1. Prepare—

O M2.5 and M2 Hex (Allen) keys

O disposable cleaning gloves

O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O cleaning cloth

O cotton swabs (Q-tips or similar)

2. Put on the gloves.
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3. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fan power
connector

UV Power
connector

Icrew

Figure 6-31 Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and
lift up the UV lamp.

4. Remove the five (5) screws that secure the UV bracket to the print block
and remove the bracket.

Figure 6-32 Removing the UV bracket
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5. Loosen the two screws securing the suction tube on the print block.

Suctiontube
SCrens

Figure 6-33 Lifting the suction tube
6. Lift the suction tube to secure it in a raised position.

7. Remove the two screws securing the covering of the roller waste collector
and remove it.

Be very careful to save the covering screws. These are special screws; if they
are lost, you need to order replacements.

Rollerwaste
- collectorscrews

Figure 6-34 Removing the roller waste collector covering
8. Remove the covering by pulling it out, and then lower it.
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9. Clean the roller waste collector and the scraper blade surface using cotton
swabs. Make sure to remove any remaining printing materials.

Figure 6-35 Cleaning the roller waste collector

%{ Before replacing the covering, you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:

1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.
4

. Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of the
blade.

5. Inspect the roller. If it is not dry, replace the blade. (See "Replacing the
Roller Scraper" on the next page.)

6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Rollerwaste
collector pins

Figure 6-36 Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the
covering (see Figure 6-34 on the previous page).
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2. Loosen the screws securing the suction tube.
r
== Securing
> SCMaNs

Figure 6-37 Suction tube correctly positioned

3. Lower the suction tube so that the hole in the panel behind the tube is
visible, and tighten the screws to secure the tube.

4. Attach the right-UV-lamp assembly to the print block and reconnect the
UV power and fan cables.
Replacing the  You should replace the roller scraper blade—
Roller Scraper « after 1,000 hours of printing.
« if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See "Cleaning the Roller Waste Collector and
Inspecting the Roller Scraper" on page 6-30.

To replace the roller scraper:
1. Prepare—
3 anew roller scraper blade
3 a Phillips 1x75 mm screwdriver
O a2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 7 on page 6-31).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 6-38 Removing the roller waste collector
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4. Remove the screws that secure the roller scraper assembly.

Figure 6-39 Removing the roller scraper screws
5. Remove the scraper blade and discard it.

a
e ™

Figure 6-40 Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown.

Toval nole
in hgﬁey
(round hola
in Blade)
[=]

Figure 6-41 Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:

« Tighten the screws in the order shown in Figure 6-42.
« Use the new screws supplied in the replacement kit

)

Figure 6-42 Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the
print block. (See steps 5 to 7 on page 6-31 in "Cleaning the Roller Waste
Collector and Inspecting the Roller Scraper".)

Aligning the You should check the alignment of the print heads—
Print Heads « once a month
« after replacing one or more heads

« if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see "Cleaning the Print Heads, Roller and
Wiper" on page 6-27).

This procedure takes about 20 minutes.
To check the alignment of the print heads:
1. Prepare—
O a transparency sheet, A-4 or Letter size

O any type of adhesive tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment wizard from the Options menu.
3. Click Next to begin, and close the cover.

4. In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.
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5. When instructed to do so, place the transparency on the build tray— next
to the left and rear edges of the tray, as shown in the following figure.

Figure 6-43 Positioning the transparency on the build tray
6. Make sure that the transparency sheet is lying flat, and tape it to the tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.
8. When the following screen appears, remove the transparency.

Head Alignment Wizard

Remaowve transparency from tray.

[~ Transparency removed.

*" Stratasys

x Lancel | <E Erevious | Mext ) I

Figure 6-44 Head Alignment wizard—steps 8-10

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Print Head Numbers
0 1 2 3 4 5 6

it i i TR it i Lk
AR W i IR 1AL

e 1
i I FEE Tl I el 1
dite AR B LU TR AT Y YT

it I EEREEE HETin LI FEEEELE LLEE
LEEreel FEEL 1 IIIILIIIH i FeE 1l Firree it

il I
I|EFIIIEIE1 IilIH“ElI ItlllIIIEFII Iilll”ltlI i !f” Illlﬁll IEIIEFIIEIII

IIIEI! !!IEI I!lli!! I l!ll IFIIL ! IIEEII I!EI I i tllilI IllllI IEIII III Iii FI IEtl IEIIEFI IEFII

Figure 6-45 Sample head-alignment test

Note: There is no column for head H7 because its alignment is used as a
reference for aligning all other heads.
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0.

10.

11.

12.

For each column of lines, use a magnifying glass or loupe to inspect pairs
of consecutive rows printed on the transparency to see where the vertical
lines align.

4

| 7

&3
[ Iilxll.I
[ IllllI
[ IllllI
[ IllllI

Figure 6-46 Comparing rows of alignment lines

67
A

Note: Itdoes not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and
lower rows are aligned, Figure 6-46. In the example shown, no change to
the head alignment is necessary. If other lines in the set are aligned, you
need to change the alignment of that head—in the next wizard screens.

In the wizard screen shown in Figure 6-44, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

Head Alignment Wizard

Head 6

Selectthe number representing the aligned lines
on the transparency.

OFF
OFF
OFF
oK
OFF

OFF
OFF 1 2 2 4 5 § 7

Stratasys

2 Help

Figure 6-47 Head alignment selection

| XK Cancel | |~(Erevious| [ Mext = ]

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next to display the next head alignment screen, and again select the
number representing the most closely aligned vertical lines on the
transparency for that print head.
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When you have finished aligning all of the heads, the following screen is

displayed.
= N Update System Parameters
. ! Do wouwant to update the alignment parameters?
Mo
% Yes
</ stratasys
2 Help | x Cancel | {Ereviousl Next g I

Figure 6-48 Parameter update confirmation
13. Continue as follows:

O To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

O To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

O If you do not want to make alignment changes in the printer at this
time, select No and click Next.

14. In the following screen, you can choose to either repeat the head
alignment procedure or close the wizard.

O If the most closely aligned vertical lines for a print head were at either
extreme, choose Yes to run the Head Alignment wizard again, then
click Next.

The transparency test will show if the heads are now properly aligned,
and—if not—the wizard will allow you to “fine tune” the alignment.

O If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

Head Alignment Wizard

PN Do you want to repeat the test?

Mo, | want to end the wizard

 Yes, | wart to print another transparency

' stratasys
2 Help | x Cancel | {Ereviousl Next g I

Figure 6-49 Repeat head alignment option

DOC-06810 Rev.B 6-39



Objet1000 Plus User Guide 6 Operating and Maintaining the Objet1000 Plus 3D Printer

Optimizing
(Calibrating)
Print Heads

The condition of the print heads directly affects the quality of printed models.
To maintain optimum printing, you should routinely test the print heads, and
calibrate them to the best working configuration possible by running the
Head Optimization wizard every 300 hours of printing.

During the optimization process, 32 samples are printed on the build tray.
After carefully inspecting and weighing each of them, you enter data in the
wizard. The wizard uses this data to optimize the heads.

If, during the optimization process, the wizard determines that a print head is
faulty—or that it is negatively affecting layer uniformity with the current head
configuration—the wizard instructs you to replace it. If this happens, you can
continue the wizard to replace the print head, or abort the wizard, to replace
the head at another time.

%( Run the Head Optimization wizard every 300 hours of printing or whenever

DOC-06810 Rev.B

the condition of print heads is negatively affecting the quality of printed
models, or if you suspect that there is a problem with one or more of the print
heads.

Note: To accurately test and calibrate print heads, they must be clean. If
necessary, run the Cleaning wizard before beginning this procedure.

To test and calibrate the print heads:
1. Prepare—
O disposable cleaning gloves (any clean, powder-free protective gloves)
O pink paper
O the Missing Nozzles ruler
O the scale supplied for use in the Head Optimization wizard

Important: Ensure that the scale is calibrated before beginning this
procedure. It is highly recommended to connect the scale to a power
source when running this wizard. If not, make sure that the scale is fully
charged.

2. Start the Head Optimization wizard from the Options menu.

e Options Help
Go ko Tray Upper Position FS

N o to Purge Positi Fé
£ St GotoPurge posiion 19 Feb 2015 14:10
Wipe F7?
G0 ko Head Inspection Fa
Go ko Tray Lower Position F10
w Purge Sequence F4 r
4 Pattern Test F3
| Material Replacement
Buil: In Tests... Chrl+-alt+E Head Filling Calibration
\f Machin Cnerati Cleaning Wizard ‘r
: achine Lperations U Calibration (G&R)
Maintenance Counters...
| X LY Lamp Replacement
Collect Service Data Fz ]
Head aAlignment
\I Head Optimization ‘r

Load Cell Calibration
Shutdown

Figure 6-50 Starting the Head Optimization wizard
3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.
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4. Read the conditions, select | Agree and click Next.

5. In the following screen, select Continue with Head optimization if you have
recently cleaned the print heads. Otherwise, cancel the wizard and run the
Cleaning wizard.

Head Optimization Wizard

Are the heads clean?

If ywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

€ Cancel this wizard to clean the heads first

' Continue with Head Optimization

-/ Stratasys

X Cancel | & Previous | Mext I

Figure 6-51 Clean print heads screen

6. In the following screen, make sure Optimize all print heads is selected,
and click Next.

Head Optimization Wizard

Select the procedure required

' Optimize all print heads.

" Replace faulty heads and optimize all heads.

-/ Stratasys

2 Help | X Cancel | Ereviousl Mext I

Figure 6-52 Procedure selection screen

7. Select the printing mode for which you want to optimize the print heads
and click Next.

Head Optimization Wizard
Select Mode
@ High Speed
() High Quality
() Digital Materials
<" Stratasys

Figure 6-53 Printing mode selection
8. Check that the build tray is empty and that the printer doors are closed.
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9. In the wizard screen, select the confirmation check boxes and click Next.

Preparations for printing

Confirm before continuing:

The tray is empty
All doars are closed

</ stratasys

’ x Lancel ] ’{Erevious] ’ ﬂext) ]

Figure 6-54 Preparation check
After warming the print block and turning on the UV lamps, the printer
prints a frame on the build tray for positioning the scale.

Figure 6-55 Scale positioning frame on the build tray
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pink paper to the surface left of the build tray, as shown below.

10. When the “Preparation for Pattern Test” screen appears, tape a sheet of

&
N

-------------

I i
Figure 6-56 Pattern Test paper positioned next to the build tray

11. Close the printer doors and click Next in the wizard screen.
12. When the Pattern Test is printed, carefully inspect it, using the Missing

Nozzles Ruler to see if there are missing lines.

Print Biock #
2 3 4 2 [ ] T

Frant of Pravier §

Figure 6-57 Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.
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13. In the following wizard screen, enter the number of missing nozzles for
each print head and click Next.

Head Optimization Wizard

O Enter Missing Nozzles

Qﬁ Open the doors and remove the pattern test paper.

Enter the number of mizzing nozzles for each head below.

a a a a a a a 0
Head 0 Head 1 Head 2 Head 3 Head 4 Head S Head EHead 7

Stratasys
2 Help XK Cancel

Figure 6-58 Enter Missing Nozzles screen

14. The wizard continues according to the number of missing nozzles you
entered.

O If there are too many missing nozzles for acceptable printing, the
wizard instructs you to replace the defective print head(s). You can do
this now, or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you
through the procedure when you click Next. Make sure you have
replacement heads and the required tools (see page 6-49). Then,
continue with "Preparing the Print Block" on page 6-50.

Head Optimization Wizard

Error: High Missing Nozzle Count

Head 1.Head 5 defective.

@ Replace defective head(z].

Abart wizard.

Stratasys
2 Help XK Cancel

Figure 6-59 Head replacement due to missing nozzles

O If the number of missing nozzles in all print heads is acceptable, the
wizard continues with the head optimization process (below).
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15. Set up the scale in the printer by performing the steps listed in the wizard
screen.

Head Optimization Wizard

Preparing the Scale

Ferfarm the steps in the order below and confirm:

[~ Position the scale on the trap and connect the cable

[ Press 'I' to tum on the scale (without the container]
[~ Wait for the scale to display '0.00°

[ Place the container on the scale

™ Press 'T'to zera the scale with the container

I Close allthe daars

- Stratasys

4 Help XK Cancel | | |

Figure 6-60 Setting up the Head Optimization scale

16. After confirming all of the items listed in the wizard screen, click Next.

Printing material (resin) is jetted from each head and its weight is
automatically recorded.

Head Optimization Wizard

Empty the Resin Container

Ferfarm the following:

[] Empty container into purge unit,
[ Return the container to the scals.
[ &) doors are closed

- Stratasys

Figure 6-61 Emptying the resin container

17. Carefully remove the resin container from the scale and empty it into the
purge unit in the printer. Then return the container to the scale.

& Caution: The resin in the container is uncured
« To prevent contact with skin, wear neoprene or nitrile gloves.
« Dispose of uncured resin in accordance with applicable regulations. By

emptying the container into the purge unit, the resin is stored in the printer's
sealed waste container.

18. Close the printer and click Next.
The printer cures the remaining resin in the container.
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19. When the following screen appears, remove the scale and clean the build
tray.

Head Optimization Wizard

Remove Scale

Confirm before continuing:

The scale and cable are removed.
The build tray iz empty and clean.

The cover is closed.

Stratasys

x Lancel

Figure 6-62 Remove the scale confirmation screen

20.In the wizard screen, confirm that the build tray is clear and that the
doors are closed and click Next.

The wizard uses the data collected to analyze the condition of the print
heads and optimize them so they print models with a uniform layer of
material.

O If the heads are in satisfactory condition, the following wizard screen
appears.

Head Optimization Wizard

N\ Print-head Optimization
\ Completed

M Click ‘Done’ to restart the printer application.

Stratasys

Figure 6-63 Final wizard screen, after optimizing print heads
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a

If the wizard determines that a print head is faulty—or that it is
negatively affecting model quality with the current head
configuration—you need to replace it. Indicate whether or not you
want to do so now.

Head Optimization Wizard
Weight Test Results
Head b defective.
@ Replace defective head(z].
Abart wizard.
Stratasys
2 Help XK Cancel

Figure 6-64 Defective print heads found

« Select Replace defective head(s) if you are prepared to replace the
print heads now (see below).
or—

« Select Abort wizard if you want to replace the print heads at
another time.

Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.

To replace print heads, you need these tools and materials:

a
a
a

m

m

replacement print head(s)
isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

a supplied cleaning cloth or equivalent
a mirror

a 5-mm flat-head screwdriver or a 3-mm hex (Allen) key (depending on
the type of print block)

the scale supplied for use in the Head Optimization wizard (Weight
Test)

the Missing Nozzles ruler

If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with "Replacing Print Heads" on
the next page.
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Replacing
Print Heads

DOC-06810 Rev.B

The condition of the print heads directly affects the quality of printed models.
You may need to replace a print head if one or more of the following
symptoms occurs:

» The Head Optimization wizard determines that a print head is defective.
(See "Optimizing (Calibrating) Print Heads" on page 6-40.)
« There are noticeable grooves in the surface of printed models.

« Visual inspection of the head reveals that its surface is damaged—peeling
or bubbles in the nozzle area.

« The printer interface displays a warning or malfunction message relating
to a print head—

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.

The Head Optimization wizard guides you through the procedure of replacing
a print head, and configures printer components to enable you to perform it.
Only replace a print head with the aid of the wizard.

The entire print-head replacement procedure takes 75—90 minutes, and
consists of the following phases:

A. Identifying the head(s) needing replacement.

=

mHE oo

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.

Preparing the print block for head replacement.
This is done automatically when you run the wizard.
Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

Performing head alignment.
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To replace a print head:
1. Prepare—
O replacement print head(s)
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

O a supplied cleaning cloth or equivalent
O a mirror

O a 5-mm flat-head screwdriver or a 3-mm hex (Allen) key (depending on
the type of print block)

O the scale supplied for use in the Head Optimization wizard (Weight
Test)

O the Missing Nozzles ruler
Important: Make sure that you have these items and that the scale is

calibrated and fully charged before continuing. It is highly recommended to
connect the scale to the wall power socket when running this wizard.

2. Start the Head Optimization wizard from the Options menu (see the figure
on page 6-40).

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select | Agree and click Next.

5. In the following screen, select Continue with Head optimization if you have
recently cleaned the print heads. Otherwise, cancel the wizard and run the
Cleaning wizard.

Head Optimization Wizard

Are the heads clean?

If wou are nat sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

€ Cancel this wizard to clean the heads first

' Continue with Head Optimization

! Stratasys

X Cancel | & Previous | Mext I

Figure 6-65 Clean print heads screen
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6. In the following screen, select Replace faulty heads, and click Next.

Head Optimization Wizard

Select the procedure required

() Optimize &l pind hesds
o) aplace Ly baadi and sphmcs ol hasd:

' stratasys
X >

Figure 6-66 Procedure selection screen

Preparingthe 7. Select the print head(s) needing replacement, and click Next.
Print Block

"Head Optimization Wizan

Select heads to be replaced

HO H1H2 H2 H4 HS HE HT
Head 0 Head 1 Head 2 Head 3 Head 4 Head 5 Head £ Head 7

B B B B B O

-/ Stratasys

[ 3 Cancel | ’{ Erevious] Mext =

Figure 6-67 Head selection screen
The printer heats and empties the print block, and prepares the printer.
(This should take up to 30 minutes.)

Head Replacement Wizard

Preparing for Head Replacement

This step can take up to 30 min.

00:05

-/ Stratasys

(K] >

Figure 6-68 Printer preparation progress screen
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The following screen appears when the printer is ready for you to replace

print heads.
Head Optimization Wiza
. 2 Print Head Replacement
‘<@ | Thenprinteris ready for you ta replace print heads
/‘4 Click 'Next' to continue.
2" stratasys
X Concel ‘ | T

Figure 6-69 Printer ready for head replacement
8. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

9. On the print block, release the upper and lower screws that secure the
print head in the block. (If necessary, you may use a screwdriver to loosen
the screws.)

Removing the
Defective Head

Figure 6-70 Releasing the locking screws

10. Press down on the upper and lower locking screws to release the print
head.

i) Mg

Figure 6-71 Releasing the print head
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11. Loosen the screws on the door of the compartment protecting the
print-head driver cards (A), then pull and lift up the door (B).

"7’:*?*?*%&?

Figure 6-72 Opening the print-head compartment

12. Pull the print-head driver card out of its socket so that the head is free (A),
and remove it from the bottom of the print block (B).

Figure 6-73 Releasing the print-head driver card to remove the head

13. Make sure that along with the head, you remove the two rubber O-ring
seals.

Figure 6-74 O-ring seals on the print head

% Important

If the seals are not removed with the head, they are probably stuck to the print
block housing. If so, remove them.
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Figure 6-75 Making sure the O-rings are not stuck to the print block

Installing the
New Head 14.Inspect the replacement head, and make sure that the O-ring seals are in

place (see Figure 6-74 on the previous page).
15. Gently insert the replacement head into the vacant slot in the print block,
and push the print-head driver card into its socket.

Note: Make sure to insert the head with the driver card facing its socket, in the
rear of the print block.

r_ﬁﬁﬁﬂ

o Y
.."-

L=

._[f 1.[[[ |

LN

Figure 6-76 Inserting the print-head driver card into its socket
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16. Push the head up until you hear it click into place, in both front and rear
holders.

ey

V¥ s

2]

#

('

§

Figure 6-77 Pushing the head into place in the print block

17. Lower the door of the print head compartment, and tighten the screws to
lock it in place.

18. Tighten the upper and lower screws that secure the print head in the print
block (see Figure 6-70 on page 6-51).
Note: Hand-tighten these screws. Do not use a screwdriver.

19. In the Replace print heads screen, select the check box to confirm that
you have replaced the head(s), and click Next.

Head Optimization Wizard

Replace print heads

Fefer to the instructions included in the head
replacement kit or click 'Help'. Confirm:

HO H1 HZ H3 H4 H5 HE HT
[~ Head 0 replaced

-/ Stratasys

4 Help | Wiew Movie |

Figure 6-78 Head replacement confirmation
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20.With your fingers, make sure that the new head is level and even with the

other heads.
- @ a
—_—
.'n':Tr_]:'.q' Y
EREE Y LAY
M [S { 1 \
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Figure 6-79 Checking the level of the new head

21. Confirm that the heads are level by selecting the check box in the
following wizard screen, and click Next.

[ Head Optimization Wizan

Installation Check

Check thatthe print heads are level and ewven.

et e

*" Stratasys

4 Help |

x LCancel | { Previous | Hest §> I

Figure 6-80 Installation-check screen

22.In the next wizard screen, confirm that you have removed all tools and
objects from the printer.

Check Printer

Canfirn bafone conlinuing

™ [The bubdiay & ey

Figure 6-81 Cleared-tray confirmation screen
23.Close the printer doors.
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The wizard continues by heating the heads, then filling and purging them.
If there are no installation problems, the optimization procedure begins,
to calibrate the print heads to the best working configuration—see
"Optimizing (Calibrating) Print Heads" on page 6-40.

If installation problems are detected, the wizard alerts you and instructs
you how to continue (see "Installation Problems" below).

24.After replacing print heads, you should check the head alignment before
using the printer to produce models. In the final wizard screen:

O Select Yes and click Done to open the Head Alignment wizard (see
"Aligning the Print Heads" on page 6-36).

3 Select No and click Done to align the heads at another time.

Head Optimization Wizard

b Print-head Optimization

@ Completed

D o weasnt 10 run thie “Haad Aligremignt’ wirand
Heal e
Eicynment

Eres

I Ma

- Stratasys

Figure 6-82 Final wizard Screen

Installation If the printer detects that there is a problem after you install print heads,
Problems relevant warning screens appear.

« If the printer software does not detect the replaced head, the following
warning screen appears.

Head Replacement Wizard

‘ One or more heads
A | not inserted correctly
Remaove and re-insert the driver cannector(s)
Y
i ™ Done
-/ Stratasys
? Help x Lancel | ‘% F |
Figure 6-83 Incorrect-installation screen
If this happens:

a. Open the print head compartment (see Figure 6-72 on page 6-52).

b. Re-insert the print-head driver card into its socket (see Figure 6-76 on
page 6-53).
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c. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.

« If the replacement head was not factory-calibrated, the following warning
screen appears.

Head Replacement Wizard B|
Inserted head does not contain
S factory data
The installed head does not contain valid data. Try
replacing it with another head. Ifthis does not
i succeed, contact Customer Support.
[ Aternate print head installed.
=" Stratasys

? Hep

Figure 6-84 Invalid-data warning screen
If this happens:

a. Remove the head and replace it with another one (starting with step 9
on page 6-51).

b. In the wizard screen, select the check box to confirm that you have
installed another print head, and click Next.

c. Contact your authorized Customer Support center about the
unformatted head.

« If the vacuum test is not successful, the replacement head was not sealed
properly during installation, and the following warning screen appears.

Head Replacement Wizard [E

Vacuum leakage detected!

Avacuum leakage was detected. The next steps will guide
yau through the procedure for re-installing the head(s).

-/ Stratasys

? Help x Lancel | ‘% k |

Figure 6-85 Vacuum-leakage warning screen
If this happens:

a. Click Next.
b. Follow the instructions on the wizard screens to re-install the head.
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Testing and
Calibrating the
UV Lamps

=

DOC-06810 Rev.B

The level of UV radiation from the lamps used for curing models can change
over time. To ensure optimum curing of models during printing, a pop-up
message reminds you to test the lamps and calibrate their level of UV
radiation after every 300 hours of printing. You do this by running the UV
Calibration Wizard, using a UV radiation meter approved for use with the
printer.

The wizard compares the measured radiation to the recommended radiation
level for each of the lamps, at each printing mode—High Speed, High Quality
and Digital Material.

When calibrating the lamps, the wizard attempts to adjust the radiation level,
if necessary.

« If the reading is within the acceptable range, the wizard continues to the
next phase.
« If further adjustment is necessary, the current phase is repeated.

« If the level of UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that the
lamp’s radiation for the printing mode is unacceptable.

Before testing and calibrating the UV lamps:

« Make sure the glass lens on each UV lamp is clean. For easy access, run the
Head Cleaning Wizard, and use the special cleaning pad supplied.

« Make sure that the UV radiation meter is available to you, and that the
sensor’s lens is clean.

To test and calibrate UV lamp radiation:
1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select Calibrate UV Intensity to adjust the power
supplied to the UV lamps so that the UV radiation is within the acceptable

range.
Select Action
Test LV Intensity.
@ Calibrate IV Intenszity.
Stratasys
7 Help x LCancel

Figure 6-86 UV Test/Calibration selection
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3. Make sure that the build tray is clear (empty), and close the printer doors.
Confirm this in the wizard screen and click Next.

Check Printer

Confirm before continuing:

[ The build tray is in place.
[ The build tray is empty.
[ The doors are clozed.

' Stratasys

X Carcel

Figure 6-87 Printer preparation

4. When the following screen appears, open the printer and place the UV
sensor at the rear edge of the tray, in the center.

x v Check Printer
—
Canfirm befare continuing:
[ The % sensar is in the center of the tray's far edge.
' Stratasys
2 Help x Cancel

Figure 6-88 Sensor placement screen

I‘-.
."Ir
f

Figure 6-89 Correct UV-sensor placement
5. Make sure that the sensor cable is securely connected to the sensor.

6. Lead the cable out of the printer so that you can close the printer, and
make sure that the cable will not interfere with the moving print block.

7. Close the printer, while checking that the sensor does not move out of
position.

8. Set the UV meter to measure mJ/cma2.
9. Set the range on the meter to 2,000.
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10.Connect the cable from the sensor to the UV meter.
11. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

12. In the wizard screen, confirm that the sensor is positioned correctly, and
click Next.
When you click Next, the UV lamps power up and stabilize. (This takes
several minutes.) Then, the print block passes over the sensor and the
wizard compares the measured radiation to the recommended level.

-

UV Intensity Measurement

(85
ﬁ ] Cunenidy iadng  Right UY lamp in Digital Hateriaks Hode

Lamp stablizaticn

Maaswa Y prognass
-—— = (15 Cycles)

Choerall progress

' stratasys

[ X Goea

g sl i I

Figure 6-90 UV measurement progress

13. When prompted by the wizard, zero (reset) the UV meter and enter the
reading (measurement).

If the UV level measured is not acceptable, the wizard calibrates the UV lamp

by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration.

UV Calibration Results

| Left UV Lamp Right LWV Lamp
T P 1801 % [1o0s) 33 % 100%)
tf * Coalibustes lamg

e 1621 X [100%) o 1767 X [100%)

of 1963 % [110%] A9 % [130%]
L Caliests largs

Figure 6-91 Results and condition of UV lamps after calibration
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After examining the UV calibration results:
1. Click Next.

2. Remove the UV meter and close the printer. After confirming the items
listed in the wizard screen, click Next.

N Wizard Completed

&

*" Stratasys

3% Cancel <72 Previous

Figure 6-92 Final UV Calibration Wizard screen

Replacing the As routine maintenance, you should replace the roller waste tube every 500
Roller Waste  hours of printing.

Tube To replace the roller waste tube:
1. Prepare—
O two cleaning cloths
O one Norprene® tube (supplied in the Start-Up Kit)
2. Make sure that the printer is either in Standby2 or in Idle mode.

3. Press F8.
or—
From the Options menu, select Go to Head Inspection.

The print block moves forward and the build tray lowers.
4. Open the printer doors and locate the tube latch on the roller waste pump.

Tube latch

Rollerwaste
pump

Figure 6-93 Pump tube latch
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5. Release the tube latch, as shown.

Tube halder

Latch

Figure 6-94 Releasing the tube latch
6. Separate the tube holder from the pump assembly.

Tube Tube holder

Tube clamp

Figure 6-95 Tube holder removed from pump assembly

7. Remove the tube from the tube holder and save the two parts of the clamp
for re-assembly.

8. Carefully detach the tube at both ends. Use the cleaning cloths to prevent
material leaking from the tubes.

9. Discard the old tube and the cleaning cloths.

These items contain uncured printing material. Dispose of them in
accordance with environmental and safety requirements.

10. Attach the ends of the new tube.

11. Place the tube clamp onto the tube as before, and insert the tube into the
tube holder, making sure that the flat surface of the clamp faces outward.
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—

Flat surfaces face outward

Figure 6-96 Left: Tube clamps; Right: Tube inserted into tube holders

12. Insert the tube holder into the pump assembly, making sure that the side
with the clamp is on the side of the pump marked SUCTION.

Tube clamp

Suction side

Figure 6-97 Tube clamp on SUCTION side of pump
13. Close the tube latch.
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14. From the Options menu, select Maintenance Counters.

15. Scroll to Dirt Pumps Tubes and click Reset.

WP Maintenance Counters {Huurs-_Jﬂ
|| File Units
Item Total Dated Warning Time
Taotal Printing time 0 03/0513 M
TETET =
Head Fan Fiter 45 09/05/13 | [4800 [ Resst |
General -
PM is Due 1} 03/05/13 3500
Last HCW activation | 09/05/13 MAA,
Geneial Eunps
Waste Punp Left (5 09/0513 | [3800
Raller Dirt Purnp 1] 09/05413 2800 Feset
Diirt Pumpsz Tubes ) 09/05/132 RO0 < Feset
Wacuum Purnp 495 09/05413 12000 Reset
Roller Suction Pump | 09/05413 3500 Ik
Waste Pump Right 1] 09/05413 3800
I_'-‘linling Hgadg
Head 0(Support] | 090543 | [N | Resst
Head1 0 03053 | [N/A
Head 2 1] 09/05/13 AA Reset i

Figure 6-98 Maintenance Counters screen

Calibrating the
Load Cells

Load cells are sensors that measure the weight of the material containers and
the waste container in the printer. It is important that you periodically check

that the weight measurements are accurate to prevent unnecessary waste of
printing materials. It is recommended that you calibrate the load cells once a

month.

To calibrate load cells:

1. Start the Load Cell Calibration wizard from the Options menu.

DOC-06810 Rev.B
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2. Make sure that there are no containers on the load cells that you want to
calibrate, select the appropriate check boxes in the wizard screen, and
click Next.

Load Cell Calibration Wizard

Select the load cells to calibrate

Gﬁ Remove each cartridge you selected and close the panels,

[Irodel - 2 Left [Irodel - 2 Right
[Irodel - 1 Left [Irodel -1 Right
[ 5upport Left [ 5upport Right
['waste Left [J'waste Right

-/ stratasys

Cancel |

Figure 6-99 Load cell selection

3. Remove the container, as instructed by the wizard, confirm this in the
wizard screen, and click Next.

4. In the next wizard screen, observe the numbers and wait until the weight
level is relatively stable—two units above or below the average level shown.

Load Cell Calibration Wizard

Values of selected load Cells

Gﬁ “wait 10 full seconds for the load cell value to stabilize.

M-2L | 2454300 2456125 M-2 R
M-1L | 2452450 2453675 M-1 R
SL 2450000 2451225 SR
~ WL 2459800 24610258 WR
) Stratasys []¥alues are stable

Figure 6-100 Weight stabilization

5. Select the check box, and click Next.

If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 4 and 5 until all of the load cells are
calibrated.
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6. Click Done in the final wizard screen.

Load Cell Calibration Wizard

Load Cell Calibration Wizard
completed

If you removed the waste container, replace it and ensure
that the drain tube is not bent.

If, after calibrating the load cells, you suspect that they are

not accurately measuring the weight of the containers,
contact your Objet service provider.

-/ Stratasys

Figure 6-101 Final wizard screen

Replacing the  The UV lamps used for curing models have a long, but limited, working life.

UV Lamps You can test and adjust their effective power with the UV Calibration wizard
(see "Testing and Calibrating the UV Lamps" on page 6-58). If you need to
replace a UV lamp, follow these instructions:

1. Make sure the printer is in offline mode.

L\

Figure 6-102 Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

Warning

Before continuing, make sure that the safety interlock is not defeated, and that
the UV lamp is not hot.

2. Start the UV Lamp Replacement wizard from the Options menu.

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer, and click Next.

UV Lamp Replacement Wizard

Inspect the build tray

Caorfirm before continuing:

[ The build tray is clear [empty).

-/ stratasys

Figure 6-103 Tray confirmation
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The axes move to the “home” position.
4. Select the UV lamp(s) to be replaced and click Next.

UV Lamp Replacement Wizarc

Select the UV lamp(s) you wish to
replace:

[ Right LI Lamp
[ Let L1 Lamp

-/ Stratasys

Figure 6-104 UV lamp selection screen

5. Disconnect the UV-lamp power connector and the UV heat fuse
connector.

Figure 6-105 Disconnecting the UV lamp

Note: Do not disconnect the power connection to the cooling fans.
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6. Loosen the screw securing the UV lamp cover (A), and pull the cover up
(B), then out (C).

Figure 6-106 Removing the UV lamp cover
7. Pull the UV lamp reflector out of the print block.

Figure 6-107 Removing the UV lamp reflector

8. Inspect the new UV lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the reflector

opposite (not next to) the print block.

Note: Extrablack strips are included in the printer Start-Up Kit. If necessary,
you can remove the black strip from the old reflector and install it in the new
reflector (as long as the black paint has not faded).

9. Discard the old UV reflector and lamp.

%{ Dispose of the used UV lamp in accordance with environmental and safety
requirements.
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Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.

« Ventilate the room thoroughly.

« Use protective gloves when collecting mercury and lamp components.

« Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.

« Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container.

10. Insert the new UV lamp/reflector unit into the housing, next to the print
block.

b’ ..1\ _l" T
W lamp A4 A Faalii= | W lamp
A5 EM ] e e o vy
v Q' Jo) Eeowrraimly (1A ssemiy

! I
. ' i I 5 ] .
Black 5111p4\ B " L . 4 \".—Elacksh'lp

'h'||||||||l.|_ e e

Figure 6-108 Print block and UV lamp assembly, showing correct
placement of black strip

11. Replace the UV lamp cover by inserting it into the slot on the bottom of
the housing, and tighten the securing screw on top.

Figure 6-109 Replacing the UV lamp cover
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12. Reconnect the power and heat fuse connectors.

Figure 6-110 Connecting the UV lamp

13. In the wizard screen, confirm that you have replaced the UV lamp(s) and
that the black strip is attached, then click Next.

UV Lamp Replacement Wizarc

UV Lamp Replacement Wizard

[ % lamp(s) replaced
[ Shadow bracket located corectly (zee help)

-/ Stratasys

Figure 6-111 UV-installation confirmation
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The wizard operates the UV lamps and checks if their power is within the
acceptable range for each printing mode.

Note: The mode currently being checked appears in the lower-left corner of
the printer interface.

UV Lamp Replacement Wizarc

~—

UV Lamp Replacement Wizard

Gﬁ Y lamp(s) warming up. This takes about 4 minutes.

-/ Stratasys

Figure 6-112 Status during UV lamp check

After replacing a UV lamp, it is recommended that you calibrate its power.
The next screen allows you to continue to the UV Calibration wizard (see
"Testing and Calibrating the UV Lamps" on page 1).

UV Lamp Replacement Wizarc

~

UV Lamp Replacement Wizard
completed

( 'CO |
.: \'.
ﬁ ',»" Do you want to run the 'LV calibration wizard' now?

1 Mo

-/ Stratasys

Figure 6-113 Final wizard screen
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Built-in Tests  The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting. All tests are run
automatically before starting a print job. In addition, you can run one or more
tests as a system check, between print jobs.

Because running the tests affects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

« The organization of printing-related tasks in categories:
O Communications

O Data cards
Temperatures
Voltages

Encoder repeatability

aaaaqn

Print-head heating
O Print-head filling
« A clear display of test results and the source of any failures, enabling you
to determine if printing is possible or worthwhile.
« The ability to monitor test results for specific components.
« Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and

software. A large number of hardware defects (or near-defects) warns you of
possible printing problems, either for current or future jobs.

%{ Stratasys recommends running the built-in tests in the following cases:

« as aroutine test, once every two weeks
« as asystem check, before major (long) jobs
« as needed, for troubleshooting

To open the Built-in Tests screen, do one of the following:

« From the Options menu, select Built-In Tests.
* Press Ctri+Alt+B.

T." Go ko Tray Upper Position FS
.-:?' A St Go ko Purge Position F& |
E Wipe F7

G0 To Head Inspection Fa
Go bo Tray Lower Position F10 |

Purge Sequence F4
Patkern Test F3 |

YWizards

Figure 6-114 Selecting Built-In Tests from the Options menu
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Test List

DOC-06810 Rev.B

The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Built In Tests

Test Mame Group Statuz  Error Description s

O FIFD Mon-lmterrupt Test [ata Card ?

O FIFO Intermupt Test [rata Card ?

O 5ystem Infa Erviranment ?

O Paramemeter S anity Check Parameters ?

OrFID RFID ?

O 5ub-Svstem Communications Communicat... ?

[ Cabin Temperature General ?

[0 Head EEPROMs Head Cards 9

[ Head Yoltages Head Cards ?

[ &mbient Temperature Heaters ? Surnrnary

O Traw Heater Heaters ? <

[ Head/Black Heaters Heaters ? B

O svstem Voltages Syztem Yol ?

O U Lamps VLamps ?

[ &xes Limits Motars ?

M1 Rlack Fillina Fillivn ? b/

< >

Tests Selection —

Graup Selection Set

’ All l ’ Mone l ’Unknownl - Mohe - W - Mohe - v .

Figure 6-115 Built In Tests screen

Test Name

This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group drop-down list at the bottom of the
screen.

Group

This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
drop-down list at the bottom of the screen.

Status

This column shows the results of each test after you run it:

v’ Test successfully completed.
X Test failed. (Double-click on a failed test’s line to review the failure details.)

7 Unknown results. (The test has not been run yet.)
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Test Selection Area

In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.

Selection Set | Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Built-in - To run the selected tests:

Tests

After you run a test, the Save and View command buttons are added to the
Built In Tests screen.

Test Results To save and view a report of all tests:

Summary

X

‘:8 Help
R Close
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> Use the Save and View command buttons.

Click the command buttons, on the right side of the screen to perform the
following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to

Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as an
HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files are
saved in the Objet1000 Plus installation folder, but you can save it in any

other folder.

View

Click to display the latest test report that you saved. (You can view other test
reports by opening the relevant files in your Web browser. To do so, open
Windows Explorer, and double click the BITReport file.)
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Close

Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of

all the tests run, using the symbols from the Status column.

v All tests successfully completed.

X At least one test failed.

7 Not all tests performed.

Test
Descriptions and
Troubleshooting

The following table lists the name of each test in the Built-in Tests suite,
together with its description and a possible reason for its failure. If you need
assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between « Disconnected communications
Communication components. cable.
+ Faulty cable.
FIFO Non-Interrupt/ | « Tests the data queue in the « If both FIFO tests fail:
FIFO Interrupt DATA PCI card. Faulty DATA_PCI card.
» Tests the Windows interrupt. + If only the FIFO Interrupt test fails:
Faulty Windows interrupt.
Encoder Tests the encoder's reliability by Faulty encoder.
comparing readings from multiple
runs along the X-axis.
System Info Compares the following parameter | Failure of RAM memory allocation in
values with the minimum the printer computer.
requirements.
+ physical memory
 available memory
» free space on disk
* monitor resolution
RFID Verifies the presence of RFID tags + Faulty RFID reader.
on all loaded material containers, and| , Faulty RFID reader power supply.
tests them by writing to and reading I
» Faulty or misaligned RFID tag.
from each one. ] . )
» High level of electromagnetic noise
around the RFID tag.
System Voltages Checks if the following voltages are + VPP power supply:
within 5% of the required voltage: Faulty head drive(s).
40V to the print heads by the VPP| * VDD power supply:
power supply Faulty height thermistor(s).
* 12V to the height thermistors by
the VDD power supply
Block Filling Analyzes the thermistor readings Faulty thermistor.
when the block is full and when it is
empty.
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Test Name

Description

Possible Reason for Failure

Interlock

Tests the interlock in the printer
cover.

 Failure of interlock mechanism.
+ Faulty latch.
* Disconnected cable.

Cabin Temperature

Tests the temperature level in the
build-tray area.

Faulty temperature sensor (OHDB).

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card(s).
the print-head driver cards.

Head Voltage Checks the control of voltages Faulty print-head driver card(s).
supplied to the print heads.

Tray Heater (Future implementation.) —

Head/Block Heaters

Tests the heaters in the print heads
and in the print-block body.

Faulty heaters or thermistors.

UV Lamps Tests each UV lamp at the High Faulty UV lamp.

Quality power level.

yp Faulty UV power supply.
Disconnected UV cable.

Axes Limit Tests the hardware and software Faulty hardware sensors.

limits of all axes. Wrong Max Position parameter.
Parameter Sanity Compares the values of all printer One or more of the printer parameters
Check parameters (in cfg files) to the is not within the required range.

required values. Details appear in the BIT report.
Vacuum Tests the vacuum level in the print

block.

+ Faulty vacuum sensor.
* Vacuum leakage.
* Wrong parameters.

Ambient Temperature

(Future implementation.)

Evacuation Sensor

Checks the flow of exhaust air from
the printer.

» Blocked air vent or duct.
+ Faulty ventilation fan.
* Faulty air-flow sensor.

DOC-06810 Rev.B
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Replacing
Waste
Containers

Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in two leak-proof containers.

Each container has a capacity of 18 kilograms of waste material. The printer
application displays a warning message when one waste container is full and
there are 17 kilograms of material in the other container. (If only one waste
container is installed, the message appears when there are 17 kilograms of
material in it.) The printer stops printing when the net weight in the second
(or only) container reaches 17.5 kilograms. When the net weight in this
container is above 17 kilograms, the software does not allow you to start a
print job (or a printing activity) until you replace (or install) a waste container.
You can monitor the weight of the waste containers in the printer interface.

& Caution

Dispose of full waste containers in accordance with environmental and safety
requirements.

%{ Empty Model-material and Support-material containers can be used as

Cleaning the
Exterior Panels

DOC-06810 Rev.B

printer-waste containers.

The painted exterior plastic panels of Objet1000 Plus 3D printers have a
durable finish, offering excellent chemical resistance to common cleaning
materials. Follow the recommendations below when cleaning these areas of
the printer.
Acceptable Cleaning Agents

« mild soap solution

« common household cleaners and window cleaners

« common commercial and industrial detergents, 5% solution in water

« alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials

« industrial solvents

« cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

« spray disinfectants
« abrasives and agents which could wear away the panel finish
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Removing Models After Printing .................................... 7-2
Removing the Build Tray From the Printer ...._.......................... 7-2
Removing the Support Material ... ... 7-3
Post-Printing Treatment for Models Made with VeroClear 7-4
Photo-Bleaching Instructions ....... ... ... ................... 7-5
Storing Models ... 7-5
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Removing Models After Printing

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on the
printer, it is best to let the printed models cool in the printer, with the cover
closed, as long as possible.

Removing the The build tray for the Objet printer is removable, which aids in the handling

Build Tray of printed models. You use a special cart to remove the build tray and transfer
From the it to the cleaning station.
Printer To remove the build tray:
1. Press F10.
or—

From the Options menu, select Go to Tray Lower Position.
The print block moves forward and the build tray lowers.

2. Raise the cart’s platform and position the docking guides as shown.

Docking guides

Anchor

Figure 7-1 Positioning the cart for tray removal

Note: Make sure that the anchor on the platform is raised above the docking
pin on the printer.

3. Lower the cart platform so that the anchor fits over the docking pin.

Diocking pin

Figure 7-2 Securing the cart to the printer
4. Pull the build tray onto the cart.
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5. Raise the cart’s platform to release it from the docking pin.
You can now move the cart to the cleaning area.

Removing the Support Material

Removing
Support Material
by Hand

Removing
Support Material
with Water
Pressure

DOC-06810 Rev.B

After printed models have cooled, the Support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the Support material, and other
factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

SUP705 (FullCure705) can be removed from printed models using the
following methods, in this order:

1. by hand

2. water pressure (in a suitable cleaning unit)

3. 1% caustic soda solution (recommended for a smooth finish)

While wearing protective gloves, break away excess Support material on the

outside of the model. For delicate models, use a toothpick, pin or small brush
after dipping the model in water.

For most models, the most efficient way to remove Support material is by
using a high-pressure water jet. Consult Stratasys Customer Support for
advice on purchasing and using suitable cleaning units for your printer and
requirements.

Use caution when cleaning delicate models with high-pressure water
systems.
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Removing Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
SUP705 with remove Support material from difficult-to-reach areas and to give the model a
Caustic Soda smooth, clean finish. The amount of time you soak the model in the solution

depends on how delicate it is and how much Support material needs to be
removed, but it is typically between half-an-hour and several hours. In any
case, you should remove as much Support material as possible before the
caustic soda treatment, and rinse the model thoroughly (with a water jet)
afterwards.

& Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.

& Caution

Caustic soda causes corrosion of the build tray.
Remove models from the build tray before treating them with caustic soda. Do
not immerse the build tray in the caustic soda solution.

Post-Printing Treatment for Models Made with VeroClear

Models made with VeroClear (RGD810) have a slight yellow tint when
removed from the printer. This is especially true for models printed with a
glossy finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As arule, best clarity is achieved when parts are printed with a matte finish,
and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

EL S
Vg .

9 ¥
&

Figure 7-3 Left: lllumination chamber; Right: Desk lamps
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Photo- Follow these instructions for photobleaching printed models.
Bleaching « The fluorescent lamps should be rated 45W, 6500K.

Instructions . . . : .
« When using desk lamps, place the models in a container lined with
aluminum foil. Use at least two lamps, more when treating models in a
large container.

« Arrange the models with enough space between them to allow light to
reach all sides of each model.

« Verify that the ambient temperature around the models is approximately
40°C (104°F). Higher temperatures may cause model distortion; lower
temperatures may not produce satisfactory results. When using desk
lamps, you can achieve the required temperature by positioning the lamps
approximately 10 cm (4 in.) above the models.

« Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching treatment
for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately 90%.

%{ More information about this treatment is available in the application note
VeroClear RGD810 Model Material.

Storing Models

Models are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming,.

« Keep printed models at room temperature and in a low-humidity
environment.

« Do not expose models to direct sunlight and other heat sources.
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